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Typographical Conventions

This document uses the conventions in the following table to distinguish elements of text.

NOTE Some pathnames in this document that are identical (except for the directory-separator character) 
on both UNIX® and Windows® platforms are specified in UNIX syntax only (that is, with forward-slash 
directory separators).

WARNING This document contains examples of text to be typed on a command line. Be sure to manually 
type the command, rather than copying and pasting it from this document. Otherwise, your command line 
may contain unrecognized characters and will not execute properly.

Convention Usage

UPPERCASE Environment variables, status codes, utility names.

Bold Program names and selected terms such as command 
parameters or environment variables that require emphasis.

Bold Gray Clickable user-interface elements (such as buttons).

Bold Olive Paths and file names. 

Italic User-supplied variables and new terms introduced in text 
or names of additional documents.

<italic> User-supplied variables that replace everything between and 
including the angle bracket delimiters (< and >).

Monospace Code samples, examples, display text, and error 
messages.
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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Revision Log

The following table identifies changes made to this document since the IBM® FileNet® Workplace 
XT initial release.

Date Revision

11/07 Adds upgrade topics “Upgrade IBM FileNet Workplace XT” on page 94 and “Upgrade 
Multiple Instances of IBM FileNet Workplace XT” on page 97.

Adds JBoss application server topics “Configure IBM FileNet Workplace XT 
(JBoss)” on page 54, “Deploy IBM FileNet Workplace XT (JBoss)” on page 69, and 
“Remove IBM FileNet Workplace XT (JBoss)” on page 103.

Adds procedures for using WebSphere 6.1.x. See “Configure IBM FileNet 
Workplace XT (WebSphere)” on page 31 and “Deploy IBM FileNet Workplace XT 
(WebSphere)” on page 60.

Adds directions for using JAWS screen reader for the setup program in “Install 
IBM FileNet Workplace XT” on page 23.

10/07 Adds information about moving from WAR file to EAR file deployment in 
“Installation Checklists” on page 14 and Task 3 “Install IBM FileNet Workplace XT” on 
page 23.

Moves the "Set permissions for the user running the application server" to 
Task 7a “Deploy IBM FileNet Workplace XT (WebSphere)” on page 60 and Task 7b 
“Deploy IBM FileNet Workplace XT (WebLogic)” on page 65.

Adds accessibility keyboard tip to Task 12 “Install IBM FileNet Workplace XT 
Application Integration” on page 83.

Corrects a few instances of incorrect references to Workplace instead of 
Workplace XT.

06/07 Initial release of the IBM FileNet Workplace XT Installation Guide.
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About this Document

Installation by an IBM FileNet Certified Professional (FCP) recommended. For more information 
on the FCP program, contact your IBM service representative.

Every effort has been made to provide you with complete installation instructions. If information 
becomes available after the documentation release from which you accessed this guide, we will 
provide an updated version of the guide on the Information Management support page 
(www.ibm.com/software/data/support/). As a general rule, you should refer to the web site to obtain 
the current version of this guide.

A new version of the guide will be distributed as of the release of any IBM FileNet Workplace XT 
Service Pack. The version number applied to the cover of this common guide will reflect the most 
recently released component Service Pack version.

Send your comments by e-mail to comments@us.ibm.com. Be sure to include the name of the 
product, the version number of the product, and the name and part number of the book (if 
applicable). If you are commenting on specific text, include the location of the text (for example, a 
chapter and section title, a table number, a page number, or a help topic title).

NOTE This guide contains links to the IBM FileNet P8 Platform online help system, where you will 
find important additional information that can help you make decisions about your installation. The 
ideal way to use this guide is as an online PDF installed within the help system. To take 
advantage of these links while using this guide, perform the documentation install task (Task 2 on 
page 22) before beginning your full IBM FileNet Workplace XT installation.

Access IBM FileNet Documentation, 
Compatibility Matrices, and Fix Packs
To access documentation for IBM FileNet products

1. Navigate to the Information Management support page (www.ibm.com/software/data/support/).

2. Select the appropriate IBM FileNet product from the "Select a category" list.

3. From the Product Support page, under Learn, click Product documentation.

4. From the Product Documentation page:

a. If necessary, click the Doc. Link for the appropriate component product to display the docu-
ment list.

b. Click the icon in the appropriate release column to access the document you need.

NOTE For a complete list of direct links to documentation relevant to this guide, see “General 
Requirements for all IBM FileNet P8 Systems” on page 23.
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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To access compatibility matrices and fix packs for IBM FileNet products

1. Navigate to the Information Management support page (www.ibm.com/software/data/support/).

2. Select the appropriate IBM FileNet product from the "Select a category" list.

3. From the Product Support page, under Download, click Fix Packs by version.

4. From the Fix Pack page:

a. Click Matrix to access the compatibility matrix.

b. Click the release number to access the fix pack you need.
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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Installation Planning and Procedures

This installation section contains the following major topics:

• “Plan the Installation” on page 13

• “Prerequisite Tasks” on page 17

• “Installation Tasks” on page 21

• “Configuration/Startup Tasks” on page 72

• “Optional Installation Tasks” on page 82
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Installation Planning Considerations
This section lists details that will help you prepare your environment for the installation of IBM 
FileNet Workplace XT. In many cases, the items you see listed are linked to more detailed 
information that will help you plan a system rollout. Review this section thoroughly before you 
start to set up IBM FileNet Workplace XT or required third-party software.

When you have completed the considerations in this section, see the “Installation Checklists” on 
page 14 for a convenient way to track your progress and collect necessary information throughout 
the prerequisite and installation stages.

Operating System Considerations
• Ensure hosts file contents. On each UNIX-based IBM FileNet P8 server that does not use 

DNS (Domain Name Service) or NIS (Network Information Service), the /etc/hosts file must 
contain the name and Internet Protocol (IP) address of all servers it will communicate with, 
including the remote database server, if applicable.

• Synchronize the time and date on all servers. System users will experience a variety of 
problems if one or more servers are not synchronized with the rest of the system.

• Adjust number of threads per process. On each HP-UX 11 or HP-UX 11i machine where an 
associated third-party JVM-based component (such as WebLogic or WebSphere®) will run, 
increase the values of the kernel parameters max_thread_proc (maximum number of threads 
per process) and nkthread (maximum number of kernel threads in the system) beyond their 
default values, which are too small for IBM FileNet applications.

Refer to the HP web page "Programmer's guide for Java® 2 HP-UX configuration for Java 
support" at http://www.hp.com/products1/unix/java/infolibrary/prog_guide/java1/configuration.htm for 
tools to determine the values for these two kernel parameters that are sufficient for IBM 
FileNet applications.

• Ensure Linux libraries are installed. To install Workplace XT on Linux®, several legacy libraries 
are required. You must install the compat-libstdc++ packages on your RedHat system prior to 
beginning your install of Workplace XT.

Application Server Considerations
Workplace XT supports container-managed environments only. Follow the instructions in this 
guide to install Workplace XT in a container-managed environment.

Network Considerations
• Ensure TCP/IP settings. Verify TCP/IP configuration settings on your UNIX or Windows® 

server.

• Ensure availability of required port numbers. Several port numbers are required by 
Workplace XT. For a list, see “IBM FileNet Workplace XT Port Numbers” on page 107.

http://www.hp.com/products1/unix/java/infolibrary/prog_guide/java1/configuration.html
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Plan the Installation
Before you begin to install IBM FileNet Workplace XT, do the following:

• Retrieve updates to IBM FileNet documentation and software. See “Access IBM FileNet 
Documentation, Compatibility Matrices, and Fix Packs” on page 9.

• Review the “Installation Planning Considerations” on page 12 for a list of tasks you should perform 
before installing Workplace XT software.

• Use the items in “Installation Checklists” on page 14 to track installation tasks and to record 
information that will be needed in later tasks.

• Read “Prerequisite Tasks” on page 17, “Installation Tasks” on page 21, “Configuration/Startup Tasks” 
on page 72, and “Optional Installation Tasks” on page 82 to become familiar with the tasks you will 
perform when setting up your Workplace XT software.

CAUTION IBM recommends you follow the planning, installation, and configuration tasks in the 
order presented in these topics. If you do otherwise, or you install IBM FileNet Workplace XT on 
machines containing components for existing IBM FileNet P8 systems, you may encounter 
unforeseen problems or be required to perform additional setup steps. See the IBM FileNet P8 
Platform Troubleshooting Guide for details. To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 9.
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Installation Checklists
The following topics provide checklists of items that must be completed for a successful 
installation of IBM FileNet Workplace XT. The lists are divided by user or role. Note that your 
organization may have different administrator roles, and that some of the responsibilities of listed 
roles may vary. 

You can print these lists and record the information as you perform the prerequisite and 
installation tasks. Where applicable, the list items indicate which role will need the information you 
provide. IBM FileNet recommends coordinating communication among the various roles to 
facilitate an easier installation process.

IT Administrator
This role administers hardware and operating systems for your environment, as well as helping to 
make decisions about machine usage and configurations such as clustering and farming. The 
information confirmed and collected in this set of checklists should be provided to the Installation 
Administrator for each component.

Determine port requirements for all the servers in your install environment. For details, see 
“IBM FileNet Workplace XT Port Numbers” on page 107.

(WebLogic) Determine the recommended MaxPermSize value for MEM_ARGS:

Security Administrator
This role administers authentication, users and groups, passwords, encryption, and general 
network access considerations for the installation and eventual use of the Workplace XT software. 
The information confirmed and collected in the following checklist items should be provided to the 
Installation Administrator, as well as to the Workplace XT administrator (Application Engine 
Administrator).

Specify the users and groups to add to the Application Engine Administrators access role:

MaxPermSize:  

Users or groups
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Specify the users and groups who will be allowed to create subscriptions to add to the 
PWDesigner access role (not specifically required to complete an install, but required to 
create subscriptions later in Workplace XT, and can also be added later):

For SSO, specify the following:

Installation Administrator
This role will actually perform installation tasks for your IBM FileNet Workplace XT software. This 
role may also perform initial configuration, setup, and startup tasks, and is typically filled by one or 
more operating system administrators on the associated computers.

Install the IBM FileNet Workplace XT documentation per Task 2 on page 22. 

Verify that at least one Content Engine object store has been created.

(WebSphere) Determine the LTPA connection password, keyfile, time-out length.

(WebLogic) Determine the Content Engine application server trust password before you 
configure your WebLogic application server for IBM FileNet Workplace XT:

In WebLogic, click your domain > Security > General > Advanced > Credentials (for this 
WebLogic domain- between domains).

(JBoss) Determine the <application-policy name="FileNet"> entry in the login-config.xml on the 
Content Engine server.

Configure the application server for IBM FileNet Workplace XT, per one of the following:

• (WebSphere) Task 1a on page 18

Users or groups

 

 

 

 

 

SSO proxy host URL:  
SSO proxy host server name:  
http port on the SSO proxy host:  
https port on the SSO proxy host:  

LTPA connection parameters:  

Content Engine WebLogic trust password:  

Content Engine application-policy name:  
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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• (WebLogic) Task 1b on page 19

• (JBoss) Task 1c on page 20

Provide the application server type and version (this must match the type and version used for 
Content Engine).

(WAR or EAR file deployment) Determine whether you will deploy the Workplace XT web 
application as a WAR or EAR file.

WAR file.

EAR file.

CAUTION If you decide to deploy a WAR file and later decide to redeploy as an EAR file you 
must uninstall Workplace XT and then reinstall the application, selecting EAR file deployment, 
to add the required files to your setup. If this change of deployment type seems likely for your 
setup we suggest that you install Workplace XT as if you would deploy an EAR file, which will 
create both WAR and EAR files, and then use the WAR file to deploy your web application.

Decide on an application name; Workplace XT is the default:

Install IBM FileNet Workplace XT. See “Install IBM FileNet Workplace XT” on page 23.

Set up IBM FileNet Workplace XT per the procedure for your platform:

– “Configure IBM FileNet Workplace XT (WebSphere)” on page 31

– “Configure IBM FileNet Workplace XT (WebLogic)” on page 45

– “Configure IBM FileNet Workplace XT (JBoss)” on page 54

Install Workplace XT software updates. See “Install IBM FileNet Workplace XT Software Updates” 
on page 58.

Install Content Engine and Process Engine client file updates. See “Install the Latest Content 
Engine and Process Engine Client Files on Workplace XT Servers” on page 59.

Deploy Workplace XT per the procedure for your platform:

– “Deploy IBM FileNet Workplace XT (WebSphere)” on page 60

– “Deploy IBM FileNet Workplace XT (WebLogic)” on page 65

– “Deploy IBM FileNet Workplace XT (JBoss)” on page 69

IBM FileNet Workplace XT Application Server Type:  
IBM FileNet Workplace XT Application Server Version:  

Application name:  
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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Prerequisite Tasks
To set up and configure prerequisite software for IBM FileNet Workplace XT

Configure your application server for IBM FileNet Workplace XT. Do one of the following:

• Task 1a on page 18 (WebSphere)

• Task 1b on page 19 (WebLogic)

• Task 1c on page 20 (JBoss)
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Task 1a: Configure an Application Server for IBM 
FileNet Workplace XT (WebSphere)
You must install WebSphere Application Server on the machine where you are going to install and 
deploy IBM FileNet Workplace XT. 

Workplace XT can be collocated with Content Engine as long as the server is appropriately sized. 
However, each instance of Workplace XT and each instance of the Content Engine must run in its 
own JVM. For assistance in sizing your system, contact your service representative.

You do not need to configure the WebSphere server before you run the IBM FileNet Workplace XT 
installer software. You will make configuration changes after the installer finishes.
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Task 1b: Configure an Application Server for IBM 
FileNet Workplace XT (WebLogic)
NOTE This task assumes you have already installed WebLogic Server on the machine where you 
are going to install and deploy IBM FileNet Workplace XT. 

Workplace XT can be collocated with Content Engine as long as the server is appropriately sized. 
However, each instance of Workplace XT and each instance of the Content Engine must run in its 
own JVM. For assistance in sizing your system, contact your service representative.

Before installing and deploying IBM FileNet Workplace XT on a WebLogic machine, you need to 
create a WebLogic domain, or have an existing domain in place. Refer to your BEA documentation 
for detailed instructions. No further configuration of the WebLogic server is needed before you run 
the Workplace XT installer software. You will make configuration changes after the installer 
finishes.
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Task 1c: Configure an Application Server for IBM 
FileNet Workplace XT (JBoss)
You must install JBoss Application Server on the machine where you are going to install and 
deploy IBM FileNet Workplace XT. 

Workplace XT can be collocated with Content Engine as long as the server is appropriately sized. 
However, each instance of Workplace XT and each instance of the Content Engine must run in its 
own JVM. For assistance in sizing your system, contact your service representative.

You do not need to configure the JBoss server before you run the IBM FileNet Workplace XT 
installer software. You will make configuration changes after the installer finishes.
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Installation Tasks
To install, configure, and deploy IBM FileNet Workplace XT

1. Install the IBM FileNet P8 Platform documentation for your application server. Do Task 2 on page 
22.

2. Install IBM FileNet Workplace XT. Do Task 3 on page 23.

3. Configure IBM FileNet Workplace XT. Do one of the following:

• Task 4a on page 31 (WebSphere)

• Task 4b on page 45 (WebLogic)

• Task 4c on page 54 (JBoss)

4. Install any available IBM FileNet Workplace XT software updates. Do Task 5 on page 58.

5. Install any available Content Engine and Process Engine client updates. Do Task 6 on page 59.

6. Deploy IBM FileNet Workplace XT. Do one of the following:

• Task 7a on page 60 (WebSphere)

• Task 7b on page 65 (WebLogic)

• Task 7c on page 69 (JBoss)
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Task 2: Install the IBM FileNet Workplace XT Documen-
tation on the Application Server
Before you install IBM FileNet Workplace XT, ensure that at least version 4.0.2-001 of the P8 
Platform documentation is installed on your IBM FileNet P8 documentation server. Version 
information is available in the IBM FileNet P8 help topic Help Directory > About the documentation - 
IBM FileNet P8 4.0. Click the Documentation version and build information link for details.

To update your IBM FileNet P8 Platform documentation, download the zip file from the IBM 
Information Management support page (www.ibm.com/software/data/support/). For details on locating 
the appropriate files, see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on 
page 9.

IBM recommends that you copy the PDF of this guide into the ecm_help/installation/WorkplaceXT 
install directory on the documentation server before you re-index for the search function. That 
way, the guide is available for future use and is searchable from the IBM FileNet P8 
Documentation online help.

To install Workplace XT documentation 

Because IBM FileNet Workplace XT is an expansion product for IBM FileNet P8 Platform, you must add 
the associated Workplace XT documentation to an existing installation of the IBM FileNet P8 Platform 
Help. This action makes Workplace XT help available to your users and enables context-sensitive help 
from the product user interface. 

For details and instructions on installing expansion product documentation, see the IBM FileNet P8 
Platform Installation and Upgrade Guide. Pay special attention to the Install Expansion Product 
Documentation subtopic in the task Install IBM FileNet P8 Platform Documentation (<your application 
server>). To download this and other IBM FileNet product documentation from the IBM web site, 
see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 9.

http://www.ibm.com/software/data/support/
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Task 3: Install IBM FileNet Workplace XT
This task includes IBM FileNet Workplace XT installation instructions for all supported application 
servers, for UNIX and Windows platforms. The installer creates the IBM FileNet Workplace XT 
folder structure and files needed for Workplace XT. After installing the files, and any necessary 
updates, you must also configure and deploy the Workplace XT application. These procedures are 
available in subsequent topics.

Before you install IBM FileNet Workplace XT

Read “Installation Planning Considerations” on page 12, and “Operating System Considerations” on 
page 12, and make sure your installation location meets the requirements specific for IBM FileNet 
Workplace XT outlined in the IBM FileNet P8 Hardware and Software Requirements. To download 
this and other IBM FileNet product documentation from the IBM web site, see “Access IBM FileNet 
Documentation, Compatibility Matrices, and Fix Packs” on page 9.

NOTES 

• To ensure proper functionality, performance, and ongoing maintenance, IBM FileNet 
Workplace XT should only be installed once per application server (or virtual machine or 
WebSphere LPAR). You can, however, deploy multiple instances of a single IBM FileNet 
Workplace XT version per application server.

• If you plan to use JAWS screen reader for the install tool, you must perform the following 
tasks before you begin the Workplace XT install:

a. Ensure that the Sun Java JRE 1.5.0 or 1.5.x is installed on the system where you will be per-
forming the install. 

b. Install the Java Access Bridge (available at http://java.sun.com).

c. Start the JAWS screen reader.

• Before logging on to Workplace XT for the first time, make sure at least one object store has 
been created on the Content Engine.

• If you plan to set up a web farm or clustered environment, in addition to these instructions, 
read and follow the instructions in the IBM FileNet P8 Platform High Availability Technical 
Notice. To download this and other IBM FileNet product documentation from the IBM web site, 
see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 9.

• You must have installed and configured a supported application server for IBM FileNet 
Workplace XT. Refer to the appropriate topic for your server type:

• “Configure an Application Server for IBM FileNet Workplace XT (WebSphere)” on page 18

• “Configure an Application Server for IBM FileNet Workplace XT (WebLogic)” on page 19

• “Configure an Application Server for IBM FileNet Workplace XT (JBoss)” on page 20

To install the IBM FileNet Workplace XT software

1. Log in to the application server:
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UNIX - Log in as a user with write access to the /bin directory and read, write, and execute 
access to the directory where you plan to install IBM FileNet Workplace XT. The user should 
also be a member of the bin group.

Windows - Log in as a member of the local Administrators group or a user with equivalent 
permissions.

2. Start the installation process in one of the following ways, depending on whether you want to run 
in interactive or silent mode:

• To install IBM FileNet Workplace XT interactively:

i. Access the IBM FileNet Workplace XT 1.1.1.0 installation software package. 

ii. Launch the appropriate Setup program (WorkplaceXT-1.1.1.0-<operating_system>.bin/
.exe) and follow the prompts, as directed in the subsequent steps in this procedure.

iii. Continue with Step 3 on page 24 below.

• To install IBM FileNet Workplace XT silently:

i. Access the IBM FileNet Workplace XT installation software package, and copy the 
silent_input.txt file to a local directory.

ii. Follow the instructions in the silent input file to edit the file to reflect the appropriate 
responses for your installation. 

iii. From a command prompt, navigate to, and execute the installer, then continue with 
Step 4 on page 28. 

– For UNIX: 

./WorkplaceXT-1.1.1.0-<operating_system>.bin -options 
<path_to_edited_input_file>/silent_input_UNIX.txt -silent 

– For Windows: 

WorkplaceXT-1.1.1.0-Win.exe -options 
“<path_to_edited_input_file>\silent_input.txt” -silent

3. Complete the Setup screens as follows:

In this screen... Perform this action...

License Agreement Review and accept the license agreement, then click Next.

Specify Installation 
Location

For the Directory Name field, enter or browse to the location 
where you want to install the IBM FileNet Workplace XT 
software (<install_path>), or accept the default location:

UNIX - /opt/FileNet/WebClient

Windows - C:\Program Files\FileNet\WebClient

Choose an Application 
Server

Select an application server and version from the drop-down 
lists. You must use the same application server type and 
version as Content Engine.
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Content Engine API 
Configuration

Configure the Content Engine API, as follows:

a. Transport Method

Select Enterprise Java Beans (EJB) from the drop-down 
list.

b. Content Engine Client Software URL

Replace the sample server name and port number 
(CEserver:2809) with the Content Engine server name 
and port number for your Content Engine server. For 
information, see “IBM FileNet Workplace XT Port Numbers” 
on page 107.

NOTE To change the Content Engine name later, or to 
connect to a different Content Engine, edit the 
WcmApiConfig.properties file. For information, see the 
IBM FileNet P8 Help topic FileNet P8 Administration > 
Application Engine Administration > Key configuration files 
and logs > WcmApiConfig.properties. The Application 
Engine information is applicable to Workplace XT.

c. Content Engine Upload URL

Replace the sample server name and port number 
(CEserver:2809) with the Content Engine server name 
and port number to use when uploading document 
content to the Content Engine server.

d. Content Engine Download URL

Replace the sample server name and port number 
(CEserver:2809) with the Content Engine server name 
and port number for your Content Engine server from 
which to download document content.

Component Manager 
URL

Enter the URL for the Component Manager on IBM FileNet 
Workplace XT.

In this screen... Perform this action...
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Choose IBM FileNet 
Workplace XT 
Deployment Type

Select the type of deployment supported by your application 
server.

• Select Deploy as WAR file if your server can deploy a WAR 
file.

• Select Deploy as EAR file if your server can deploy an EAR 
file. Enter an Application Name for the deployed application. 
The default is Workplace XT.

CAUTION If you decide to deploy a WAR file and later decide to 
redeploy as an EAR file you must uninstall Workplace XT and 
then reinstall the application, selecting EAR file deployment, to 
add the required files to your setup. If this change of 
deployment type seems likely for your setup we suggest that 
you install Workplace XT as if you would deploy an EAR file, 
which will create both WAR and EAR files, and then use the 
WAR file to deploy your web application.

Specify Documentation 
URL

For the documentation URL, enter the Documentation Server 
URL, which is where the IBM FileNet P8 Platform 
Documentation (including the IBM FileNet Workplace XT 
documentation) is installed.

Your entry must be in the following format:

http://<docserver:port#>/<ecm_help>/

where: 

docserver is the name of the Java application server.

port# is the port number.

ecm_help is the root folder of the documentation website. 
You can use multi-part root folders (for example, /docs/
ecm_help) if your application server supports them.

See “Install the IBM FileNet Workplace XT Documentation on the 
Application Server” on page 22 for more information. 

NOTE For information on how to reconfigure the Documentation 
URL after installation is completed, look for information on the 
documentationServer parameter in the IBM FileNet P8 Help 
topic FileNet P8 Administration > Application Engine Administration > 
Key configuration files and logs > Bootstrap properties.

In this screen... Perform this action...
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Specify Configuration 
Directory

Accept the default location or browse to the location where you 
want to store the configuration files.

UNIX - /opt/FileNet/Config/WebClient

Windows - C:\Program Files\FileNet\Config\WebClient

NOTES 

• IBM recommends that you enter the same path that you 
entered for the initial installation of Workplace XT, in the 
earlier “Specify Installation Location” panel of the wizard.

• The configuration files for an EAR file deployment, a web 
farm, or a clustered environment must be located in a 
shared folder that is accessible by all copies of the 
Workplace XT application. For more information, see the 
IBM FileNet P8 Platform High Availability Technical Notice. 
To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM 
FileNet Documentation, Compatibility Matrices, and Fix Packs” 
on page 9.

The configuration files will be installed to:

UNIX - <install_path>/FileNet/Config/WebClient

Windows - <install_path>\FileNet\Config\WebClient

CAUTION A UNC admin share (for example, \\server\C$) for a 
shared location is not supported. You can use an ordinary file 
share.

Specify Upload Location The Upload Directory is the directory used by Workplace XT to 
store temporary copies of files uploaded to Workplace XT.

Accept the default option or browse for a directory to hold the 
temporary upload files.

CAUTION A UNC admin share (for example, \\server\C$) for a 
shared upload directory location is not supported. You can use 
an ordinary file share.

Specify Download 
Location

The Download Directory is the directory used by Workplace XT 
to store temporary copies of files downloaded from Workplace 
XT. 

Accept the default option or browse for a directory to hold the 
temporary download files.

CAUTION A UNC admin share (for example, \\server\C$) for a 
shared download directory is not supported. You can use an 
ordinary file share.

In this screen... Perform this action...
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4. (UNIX only) Log out and log in again to set the environment variables. 

5. View the web_client_install_log_1.1.1.0.txt file located in

UNIX - <install_path>/FileNet/WebClient

Specify Log File Location Accept the default option or browse for a directory to place the 
log files.

Configure User Token 
Security

Configure user token security.

a. If needed, select the check box to create maximum 
strength keys.

By default this option is not selected and Setup creates 
limited strength (128-bit) keys. If you select this option, 
the installer creates 448-bit keys. 

b. Enter the number of keys to use. A large number of keys 
is more secure.

c. Make a note of the user token crypto key path.

The UTCryptoKeyFile.properties file contains the user 
token cryptography key used by IBM FileNet P8 
applications to launch into each other without the need 
for additional login. 

The default User Token Crypto Key file path is:

UNIX - <install_path>/FileNet/Authentication/

Windows - <install_path>\FileNet\Authentication\

CAUTION For multiple applications to pass user tokens to each 
other, each participating application must use the same 
encryption key file. Copy the UTCryptoKeyFile.properties file 
installed with Workplace XT to all servers that are hosting a 
token-sharing application.

User Selections Review the list of selections you have made. 

NOTE More than one panel might be needed to display your 
selections. 

Please Read the 
Summary Information 
Below

Verify your selections, and click Install.

Completing IBM FileNet 
Workplace XT Setup 

Click Finish to complete the installation.

In this screen... Perform this action...
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Windows - <install_path>\FileNet\WebClient

where <install_path> is the location where you installed Workplace XT. The default is /opt 
(UNIX) or C:\Program Files (Windows).

Verify that no errors or failures were logged. Correct any errors before you proceed.

6. (Solaris only) Set the anon ports.

When Solaris first starts up, it takes the first several ports, called anon ports, for its 
communication daemons. By default, the maximum tcp_smallest_anon_port is 32768. IBM 
FileNet uses several ports higher than 32768. See “IBM FileNet Workplace XT Port Numbers” on 
page 107 for details on which ports IBM FileNet uses.

To use these IBM FileNet ports on Solaris-based systems, you must first enable the ports by 
setting the smallest anon port to 32778. When you do this, the ports used by Solaris 
communication daemons will be 32778 or greater, leaving port 32777 available for IBM 
FileNet use.

The Solaris platform provides several different tools, such as the netstat command, to 
determine if a port is in use.

a. To determine the current tcp_smallest_anon_port setting, enter the following at the com-
mand prompt:

ndd -get /dev/tcp tcp_smallest_anon_port

If the port is less than 32778, you must enable port 32777.

b. To enable port 32777 on Solaris9, use a text editor to edit the /etc/rc2.d/S69inet file.

Add the following line:

ndd -set /dev/tcp tcp_smallest_anon_port 32778

NOTE Put this entry in the file before the exit 0 entry at the bottom of the file.

c. To enable port 32777 on Solaris10, use a text editor to edit the /lib/svc/method/net-init file.

Add the following line:

ndd -set /dev/tcp tcp_smallest_anon_port 32778

NOTE Put this entry in the file before the exit 0 entry at the bottom of the file.

d. Reboot the IBM FileNet Workplace XT server to force the release of ports required by Work-
place XT that may be in use by the operating system. Failure to reboot after these changes 
are made can result in the port being unavailable, generating OpenSocket errors.

7. (UNIX only) Verify that the P8TASKMAN_HOME system environment variable is set to the 
following:

P8TASKMAN_HOME=<install_path>/FileNet/WebClient/CommonFiles
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8. Follow the instructions for your application server to configure Workplace XT:

• Task 4a on page 31 (WebSphere)

• Task 4b on page 45 (WebLogic)

• Task 4c on page 54 (JBoss)
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Task 4a: Configure IBM FileNet Workplace XT (Web-
Sphere)
This topic covers the configuration of your IBM FileNet Workplace XT application on WebSphere.

NOTE IBM FileNet Workplace XT uses cookie names for passing session information between Workplace 
XT and the client browser. This session information affects how Workplace XT interacts with several 
applets, such as Process Designer, Search Designer, and Process Simulator. To avoid forcing end users to 
log in individually to each applet, do not configure the application server to use application-unique cookie 
names for the deployed Workplace XT. For best results, use JSESSIONID for the cookie name.

To configure IBM FileNet Workplace XT

Perform the following high-level steps in the order listed, using the referenced detailed procedures 
for each step.

1. If you are using SSO, edit web.xml. See “To edit web.xml for SSO (optional)” on page 31.

2. If you plan to use Application Integration or another option that requires user tokens, configure 
WebSphere to support it. Do one of the following:

• “To configure WebSphere to support user tokens for Workplace XT (including Application Integra-
tion) (optional) (WebSphere 6.0.x)” on page 33

• “To configure WebSphere to support user tokens for Workplace XT (including Application Integra-
tion) (optional) (6.1.x)” on page 34

3. Configure Workplace XT. Do one of the following:

• “To configure Workplace XT (WebSphere 6.0.x)” on page 36

• “To configure Workplace XT (WebSphere 6.1.x)” on page 39

4. Configure the server ports. See “To configure the server ports (optional)” on page 43.

To edit web.xml for SSO (optional)

NOTES

• Perform this procedure only if your site uses SSO. This procedure modifies the web.xml to 
enable SSO.

• SSO in an IBM Tivoli Access Manager environment may require additional configuration in 
WebSphere. If you are implementing SSO in an IBM Tivoli Access Manager (TAM) WebSEAL 
6.0 environment, the junction you use for Workplace XT must be a transparent junction. For 
more details, see your IBM product documentation.

1. Make a back-up copy of web.xml.

UNIX - <install_path>/FileNet/WebClient//WorkplaceXT/WEB-INF/web.xml

Windows - <Workplace_XT_path>\FileNet\WebClient\WorkplaceXT\WEB-INF\web.xml

2. Use a text editor to open and edit web.xml.
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3. Ensure that the parameter challengeProxyEnabled is set to false, as in:

<init-param>
                <!--
                     Set this parameter to false if deployment is on WebSphere 6, and 
see the commented out
                     sections at the bottom of this file for additional configuration 
adjustments.
                -->
  <param-name>challengeProxyEnabled</param-name> 
  <param-value>false</param-value> 
</init-param>

4. Set the parameter perimeterChallengeMode to true, as in:

 <init-param>
    <param-name>perimeterChallengeMode</param-name>
    <param-value>true</param-value>
  </init-param>

5. Add the following security role element just after the security-constraint section:

</security-constraint>
- <!--  add login-config element 
  --> 

<security-role>
<description>everyone</description>
<role-name>everyone</role-name>

</security-role>

6. As needed, set the ssoProxyContextPath, ssoProxyHost, ssoProxyPort, and 
ssoProxySSLPort. These parameter values are used to modify one or more elements of the 
native URL that Workplace XT sees on a request. Wherever the value of an SSO proxy host 
element in the URL request is different from the equivalent information for the host where 
Workplace XT is deployed, then you must set the corresponding sso* parameter for that 
element in the URL to the value for the SSO proxy host. 

The default settings are:

<init-param>
<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyHost</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyPort</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxySSLPort</param-name>
<param-value></param-value>

</init-param>

In general, the init parameters above must be configured as follows:

• ssoProxyContextPath: Set the value to the context path of the SSO proxy host URL. This is the 
path portion of the URL that appears after the server name, and which represents top-level access 
to the Workplace XT application. For example, if the IBM FileNet Workplace XT deploy host URL is 
http://deploy_server:2809/WorkplaceXT and the SSO proxy host URL is 
http://sso_proxy_server.domain.com/fn/WorkplaceXT, then use the following:
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<param-name>ssoProxyContextPath</param-name>
<param-value>/fn/WorkplaceXT</param-value>

• ssoProxyHost: Set the value to the SSO proxy host server name. Typically, this will be a full 
domain-qualified hostname. For example, if the host URL where Workplace XT is deployed is 
http://deploy_server/WorkplaceXT and the corresponding SSO proxy host URL is 
http://sso_proxy_server/WorkplaceXT, then use the following:

<param-name>ssoProxyHost</param-name>
<param-value>sso_proxy_server</param-value>

• ssoProxyPort: Set the value to the http port on the SSO proxy host. For example:

<param-name>ssoProxyPort</param-name>
<param-value>80</param-value>

• ssoProxySSLPort: Set the value to the https port on the SSO proxy host, if defined and/or used to 
access Workplace XT pages. For example:

<param-name>ssoProxySSLPort</param-name>
ram-value>443</param-value>

7. Save your changes to web.xml and close the file.

To configure WebSphere to support user tokens for Workplace XT (including Application 
Integration) (optional) (WebSphere 6.0.x)

NOTE The configuration steps that follow enable the generation and acceptance of user tokens on 
the server. These settings can be verified in the Bootstrap Settings in the Site Preferences.

1. Stop the WebSphere server, if it is running.

2. Copy the authentication-websphere.jar file from here:

<install_path>/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:

<WAS_home>/AppServer/lib/ext

3. Copy the log4j-1.2.13.jar file from here:

<install_path>/FileNet/WebClient/WorkplaceXT/WEB-INF/lib

to here:

<WAS_home>/AppServer/lib/ext

4. Enable JAAS.

a. Open the WebSphere Administrative Console.

b. Navigate to Servers > Application servers > server_name  > Java and Process Management 
> Process Definition > Java Virtual Machine > Generic JVM Arguments.

c. If there is an entry, add a space after it, then add the following (if there is no entry, do not 
add the space):
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UNIX:
-Djava.security.auth.login.config=<install_path>/CE_API/config/samples/
jaas.conf.WebSphere

Windows:
-Djava.security.auth.login.config=<install_path>\CE_API\config\samples\ 
jaas.conf.WebSphere

d. Click Apply.

NOTE Do not perform Step e through Step h if you are enabling JAAS for any component using 
SSO. Creating the custom module makes SSO unusable.

e. Navigate to Security > Global Security > JAAS configuration > System logins > 
WEB_INBOUND > JAAS login modules.

f. Click New to create a new custom login module.

g. Enter the following for the Module class name setting:

com.filenet.ae.authentication.loginmodule.UserTokenWSLoginModule

h. Click Apply, and click Save to apply changes to the master configuration. Click Save.

5. Enable trust association and specify interceptor setting.

a. Navigate to Security > Global security > Authentication mechanisms > LTPA > Trust associ-
ation.

b. Under General Properties, select Enable trust association, then click Apply.

c. Under Additional Properties, click Interceptors.

d. Click New, and enter the following for the Interceptor class name:

com.filenet.ae.authentication.tai.UserTokenInterceptor

e. Click Apply, and click Save to apply changes to the master configuration. Click Save.

6. Restart WebSphere.

NOTE There is a known issue in WebSphere 6.0.2.17 that returns an error at the login page after 
the trust association is enabled. This issue is fixed in 6.0.2.19.

To configure WebSphere to support user tokens for Workplace XT (including Application 
Integration) (optional) (6.1.x)

NOTE The configuration steps that follow enable the generation and acceptance of user tokens on 
the server. These settings can be verified in the Bootstrap Settings in the Site Preferences.

1. Stop the WebSphere server, if it is running.
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2. Copy the authentication-websphere.jar file from here:

<install_path>/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:

<WAS_home>/AppServer/lib/ext

3. Copy the log4j-1.2.13.jar file from here:

<install_path>/FileNet/WebClient/WorkplaceXT/WEB-INF/lib

to here:

<WAS_home>/AppServer/lib/ext

4. Enable JAAS.

a. Open the WebSphere Administrative Console.

b. Navigate to Servers > Application servers > server_name  > Java and Process Management 
> Process Definition > Java Virtual Machine > Generic JVM Arguments.

c. If there is an entry, add a space after it, then add the following (if there is no entry, do not 
add the space):

UNIX:
-Djava.security.auth.login.config=<install_path>/CE_API/config/samples/
jaas.conf.WebSphere

Windows:
-Djava.security.auth.login.config=<install_path>\CE_API\config\samples\ 
jaas.conf.WebSphere

d. Click Apply.

NOTE Do not perform Step e through Step h if you are enabling JAAS for any component using 
SSO. Creating the custom module makes SSO unusable.

e. Navigate to Security > Secure administration, applications and infrastructure > Java Authen-
tication and Authorization Service > System logins > WEB_INBOUND > JAAS login mod-
ules.

f. Click New to create a new custom login module.

g. Enter the following for the Module class name setting:

com.filenet.ae.authentication.loginmodule.UserTokenWSLoginModule

h. Click Apply, and click Save directly to the master configuration.

5. Enable trust association and specify interceptor setting.

a. Navigate to Security > Secure administration, applications and infrastructure > Web security 
> Trust association.

b. Under General Properties, select Enable trust association, then click Apply.

c. Under Additional Properties, click Interceptors.
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE



Task 4a: Configure IBM FileNet Workplace XT (WebSphere)
To configure Workplace XT (WebSphere 6.0.x)

36
d. Click New, and enter the following for the Interceptor class name:

com.filenet.ae.authentication.tai.UserTokenInterceptor

e. Click Apply, and click Save directly to the master configuration.

6. Restart WebSphere.

To configure Workplace XT (WebSphere 6.0.x)

1. Open the WebSphere Administrative Console.

2. Set JVM settings for memory and UTF-8 encoding.

a. Navigate to Servers > Application servers > server_name > Java and Process Management 
> Process Definition > Java Virtual Machine.

b. Enter the numbers for the Initial and Maximum Heap Size.

NOTE Refer to your application server vendor's recommendation for Initial and Maximum 
heap size values. For more information on performance tuning, see the IBM FileNet P8 
Platform Performance Tuning Guide. To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 9.

c. Click Apply to save your changes.

d. Click Custom Properties.

e. Click New.

f. In the Name field, enter

client.encoding.override 

g. In the Value field, enter 

UTF-8

h. Click Apply, click Save, and then click Save changes to the master configuration.

3. Enable Application Integration installation.

a. Navigate to Environment > Virtual Hosts > default_host (or the host your application is 
deployed under).

b. Click MIME Types, then click New.

c. In the MIME Type field, enter application/octet-stream.

d. In the Extension(s) field, enter exe. Click OK.

e. Click Apply, click Save, and then click Save changes to the master configuration.

4. Configure Lightweight Third Party Authentication (LTPA).

NOTE If you already have Application Engine or Workplace XT in your environment, skip the 
following step (Step a).
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a. On the Content Engine WebSphere server, do the following:

i. Log in to the Administrative Console.

ii. Navigate to Security > Global Security > Authentication > Authentication mechanisms > 
LTPA

iii. Enter and confirm a password. This same password will be used during configuration on 
the IBM FileNet Workplace XT server, below.

iv. Enter a path for the Key File Name. For example, /opt/LTPA/<ltpa_key_name>.

v. Click Generate Keys.

vi. Click Save, and then click Save changes to the master configuration.

vii. Navigate to Security > Global Security.

viii. From the right side of the panel, select Authentication > Authentication mechanisms > 
LTPA.

ix. Click Export Keys.

NOTE If you already have Application Engine or Workplace XT in your environment, skip the 
following step (Step b).

b. On the IBM FileNet Workplace XT server, do the following:

i. Copy the key file from the location you specified above to the IBM FileNet Workplace XT 
server. For example, /opt/LTPA/<ltpa_key_name>.

ii. Log in to the WebSphere Administrative Console.

iii. Navigate to Security > Global Security.

iv. From the right side of the panel, select Authentication > Authentication Mechanisms > 
LTPA.

v. Enter a value for the timeout that is larger than the default. For example, if the timeout 
value is set to less than 2 hours, end users will not be able to log in to IBM FileNet Work-
place XT after 2 hours.

vi. Enter the same password that you entered for Content Engine above.

vii. Enter the path for the key file that you copied to the IBM FileNet Workplace XT server. 
For example, /opt/LTPA/<ltpa_key_name>.

viii. Click Import Keys.

5. Configure Lightweight Directory Access Protocol (LDAP).

a. Navigate to Security > Global Security.

b. From the right side of the panel, click LDAP.

c. Configure the LDAP provider settings to exactly match the settings from the Content Engine 
server.

d. Click Apply.
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e. Click Advanced LDAP Settings.

f. Configure the settings here to exactly match the settings from the Content Engine server.

g. Click Apply, then Save. Click Save changes to the Master Configuration.

NOTE If you are using Tivoli as your directory server, perform Step h. For all other directory 
servers, continue with Step i, below.

h. (Tivoli only) Configure WebSphere security for Tivoli.

i. Shut down Websphere.

ii. On the Workplace XT application server, back up the security.xml file. The file is in the 
following location:

<install_path>/WebSphere/AppServer/profiles/<appserver_name>/config/cells/
<ServerName>Node01Cell/

iii. On the Content Engine WebSphere server, open the security.xml file, located in a path 
similar to the one in Step ii. Copy the “userRegistries”, “searchFilter”, and “host” entries, 
as shown in the example below (in bold). Do not use the example settings, as your set-
tings will be different.

  <userRegistries xmi:type="security:LocalOSUserRegistry" 
xmi:id="LocalOSUserRegistry" serverId="" serverPassword="{xor}" realm="" 
useRegistryServerId="true" primaryAdminId=""/>

  <userRegistries xmi:type="security:CustomUserRegistry" 
xmi:id="CustomUserRegistry_1" useRegistryServerId="true" primaryAdminId="" 
customRegistryClassName="com.ibm.websphere.security.FileRegistrySample"/>

  <userRegistries xmi:type="security:LDAPUserRegistry" 
xmi:id="LDAPUserRegistry_1" serverId="CEAdmin" 
serverPassword="{xor}Dz4sLCgwLTtu" realm="vauxhall:389" ignoreCase="true" 
useRegistryServerId="false" primaryAdminId="CEAdmin" 
type="IBM_DIRECTORY_SERVER" sslEnabled="false" sslConfig="" 
baseDN="dc=gardens" 
bindDN="cn=CEAdmin,ou=Shared,ou=Engineering,ou=FileNet,dc=gardens" 
bindPassword="{xor}Dz4sLCgwLTtu" searchTimeout="120" reuseConnection="true">

    <searchFilter xmi:id="LDAPSearchFilter_1" 
userFilter="(&amp;(cn=%v)(objectclass=person))" 
groupFilter="(&amp;(cn=%v)(|(objectclass=groupOfNames)(objectclass=groupOfUn
iqueNames)))" userIdMap="cn" groupIdMap="*:cn" 
groupMemberIdMap="memberof:member" certificateMapMode="EXACT_DN" 
certificateFilter=""/>

    <hosts xmi:id="EndPoint_1" host="vauxhall" port="389"/>

  </userRegistries>

  <userRegistries xmi:type="security:WIMUserRegistry" 
xmi:id="WIMUserRegistry_1" serverId="" serverPassword="{xor}" 
realm="defaultWIMFileBasedRealm" ignoreCase="true" 
useRegistryServerId="false" primaryAdminId="administrator" 
registryClassName="com.ibm.ws.wim.registry.WIMUserRegistry"/>

  <authConfig xmi:id="AuthorizationConfig_1" useJACCProvider="false">

    <authorizationProviders xmi:id="AuthorizationProvider_1" 
j2eePolicyImplClassName="com.tivoli.pd.as.jacc.TAMPolicy" name="Tivoli Access 
Manager" 
policyConfigurationFactoryImplClassName="com.tivoli.pd.as.jacc.TAMPolicyConf
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igurationFactory" 
roleConfigurationFactoryImplClassName="com.tivoli.pd.as.jacc.TAMRoleConfigur
ationFactory" 
initializeJACCProviderClassName="com.tivoli.pd.as.jacc.cfg.TAMConfigInitiali
ze" requiresEJBArgumentsPolicyContextHandler="false" 
supportsDynamicModuleUpdates="true"/>

  </authConfig>

iv. On the Workplace XT WebSphere server, open the security.xml file for editing, and 
paste in the “userRegistries”, “searchFilter”, and “host” entries you copied from the Con-
tent Engine file, in the location shown above.

v. Save and close the file.

vi. Restart WebSphere, and log in to the Administrative Console.

NOTE If you make any changes to your LDAP server settings in the WebSphere 
Administrative Console after updating the security.xml file, these settings will be 
overwritten and you will have to add the entries back to the file.

i. Navigate to Security > Global Security.

j. Turn on (check) the Enabled flag.

k. Turn off (uncheck) Enforce Java 2 Security.

l. From the Active Authentication Mechanism drop down list, select LTPA.

NOTE Content Engine must also be set to use LTPA for Active Authentication.

m. Click Apply, and then click Save changes to the Master Configuration.

6. Set permissions for the user running the application server. 

If the user who will be running the application server is different from the user that installed 
IBM FileNet Workplace XT, you must give the user read/write permissions on the following 
folder:

UNIX - <install_path>/FileNet/WebClient

Windows - <install_path>\FileNet\WebClient (only required for NTFS formatted partitions)

where <install_path> is the location where you installed Workplace XT. The default is /opt 
(UNIX) or C:\Program Files (Windows).

7. Stop and restart the application server. 

8. Continue with “To configure the server ports (optional)” on page 43, or continue with “Install IBM 
FileNet Workplace XT Software Updates” on page 58.

To configure Workplace XT (WebSphere 6.1.x)

1. Open the WebSphere Administrative Console.

2. Set JVM settings for memory and UTF-8 encoding.

a. Navigate to Servers > Application servers > server_name  > Java and Process Management 
> Process Definition > Java Virtual Machine.
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b. Enter the numbers for the Initial and Maximum Heap Size.

NOTE Refer to your application server vendor's recommendation for Initial and Maximum 
heap size values. For more information on performance tuning, see the IBM FileNet P8 
Platform Performance Tuning Guide. To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 9.

c. Click Apply to save your changes.

d. Click Custom Properties.

e. Click New.

f. In the Name field, enter

client.encoding.override 

g. In the Value field, enter 

UTF-8

h. Click Apply, then click Save. 

3. Enable Application Integration installation.

a. From the Administrative Console, expand Environment. Click Virtual Hosts.

b. Click the default_host (or the host your application is deployed under).

c. Click MIME Types, then click New.

d. In the MIME Type field, enter application/octet-stream.

e. In the Extension(s) field, enter exe. Click OK.

f. Click Apply, then click Save.

4. Configure Lightweight Third Party Authentication (LTPA).

NOTE If you already have Application Engine or Workplace XT in your environment, skip the 
following step (Step a).

a. On the Content Engine WebSphere server, do the following:

i. Log in to the Administrative Console.

ii. Navigate to Security > Secure administration, applications and infrastructure. 

iii. Under Authentication, click Authentication mechanisms and expiration.

iv. Under Cross-cell single sign-on, enter and confirm a password. This same password will 
be used during configuration on the IBM FileNet Workplace XT server, below.

v. Enter a fully qualified path for the key file name. For example, /opt/LTPA/
<ltpa_key_name>.

vi. Under Key Generation, click Generate Keys.

vii. Click Apply, and then click Save directly to the master configuration.
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viii. Under Authentication, click Authentication mechanisms and expiration.

ix. Click Export Keys.

NOTE If you already have Application Engine or Workplace XT on this application server (for 
example, if you are performing this configuration as part of a Workplace XT upgrade), skip the 
following step (Step b).

b. On the IBM FileNet Workplace XT WebSphere server, do the following:

i. Copy the key file from the location you specified above to the IBM FileNet Workplace XT 
server. For example, /opt/LTPA/<ltpa_key_name>.

ii. Log in to the WebSphere Administrative Console.

iii. Navigate to Security > Secure administration, applications and infrastructure. 

iv. Under Authentication, click Authentication mechanisms and expiration.

v. Enter a value for the timeout that is larger than the default. For example, if the timeout 
value is set to less than 2 hours, end users will not be able to log in to IBM FileNet Work-
place XT after 2 hours.

vi. Enter and confirm the same password that you entered for Content Engine above.

vii. Enter the fully qualified path for the key file that you copied to the IBM FileNet Work-
place XT server. For example, /opt/LTPA/<ltpa_key_name>.

viii. Click Import keys.

ix. Click Apply, and then click Save directly to the master configuration.

5. Configure Lightweight Directory Access Protocol (LDAP).

a. On the Workplace XT WebSphere Administration Console, navigate to Security > Secure 
administration, applications and infrastructure.

b. Under User account repository, in the Available realm definitions dropdown, select Standal-
one LDAP registry.

c. Click Set as current.

d. Under Administrative security, clear the Enable administrative security checkbox.

e. Click Apply, and then click Save directly to the master configuration.

f. Under User account repository, click Configure.

g. Configure the settings here to exactly match the settings from the Content Engine server.

h. Click Apply, and then click Save directly to the master configuration.

NOTE If you see a message about the ID not existing in the user repository, ignore it.

NOTE If you are using Tivoli as your directory server, perform Step i. For all other directory 
servers, continue with Step j, below.

i. (Tivoli only) Configure WebSphere security for Tivoli.

i. Shut down Websphere.
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ii. On the Workplace XT application server, back up the security.xml file. The file is in the 
following location:

<install_path>/WebSphere/AppServer/profiles/<appserver_name>/config/cells/
<ServerName>Node01Cell/

iii. On the Content Engine WebSphere server, open the security.xml file, located in a path 
similar to the one in Step iii. Copy the “userRegistries”, “searchFilter”, and “host” entries, 
as shown in the example below (in bold). Do not use the example settings, as your set-
tings will be different.

  <userRegistries xmi:type="security:LocalOSUserRegistry" 
xmi:id="LocalOSUserRegistry" serverId="" serverPassword="{xor}" realm="" 
useRegistryServerId="true" primaryAdminId=""/>

  <userRegistries xmi:type="security:CustomUserRegistry" 
xmi:id="CustomUserRegistry_1" useRegistryServerId="true" primaryAdminId="" 
customRegistryClassName="com.ibm.websphere.security.FileRegistrySample"/>

  <userRegistries xmi:type="security:LDAPUserRegistry" 
xmi:id="LDAPUserRegistry_1" serverId="CEAdmin" 
serverPassword="{xor}Dz4sLCgwLTtu" realm="vauxhall:389" ignoreCase="true" 
useRegistryServerId="false" primaryAdminId="CEAdmin" 
type="IBM_DIRECTORY_SERVER" sslEnabled="false" sslConfig="" 
baseDN="dc=gardens" 
bindDN="cn=CEAdmin,ou=Shared,ou=Engineering,ou=FileNet,dc=gardens" 
bindPassword="{xor}Dz4sLCgwLTtu" searchTimeout="120" reuseConnection="true">

    <searchFilter xmi:id="LDAPSearchFilter_1" 
userFilter="(&amp;(cn=%v)(objectclass=person))" 
groupFilter="(&amp;(cn=%v)(|(objectclass=groupOfNames)(objectclass=groupOfUn
iqueNames)))" userIdMap="cn" groupIdMap="*:cn" 
groupMemberIdMap="memberof:member" certificateMapMode="EXACT_DN" 
certificateFilter=""/>

    <hosts xmi:id="EndPoint_1" host="vauxhall" port="389"/>

  </userRegistries>

  <userRegistries xmi:type="security:WIMUserRegistry" 
xmi:id="WIMUserRegistry_1" serverId="" serverPassword="{xor}" 
realm="defaultWIMFileBasedRealm" ignoreCase="true" 
useRegistryServerId="false" primaryAdminId="administrator" 
registryClassName="com.ibm.ws.wim.registry.WIMUserRegistry"/>

  <authConfig xmi:id="AuthorizationConfig_1" useJACCProvider="false">

    <authorizationProviders xmi:id="AuthorizationProvider_1" 
j2eePolicyImplClassName="com.tivoli.pd.as.jacc.TAMPolicy" name="Tivoli Access 
Manager" 
policyConfigurationFactoryImplClassName="com.tivoli.pd.as.jacc.TAMPolicyConf
igurationFactory" 
roleConfigurationFactoryImplClassName="com.tivoli.pd.as.jacc.TAMRoleConfigur
ationFactory" 
initializeJACCProviderClassName="com.tivoli.pd.as.jacc.cfg.TAMConfigInitiali
ze" requiresEJBArgumentsPolicyContextHandler="false" 
supportsDynamicModuleUpdates="true"/>

  </authConfig>

iv. On the Workplace XT WebSphere server, open the security.xml file for editing, and 
paste in the “userRegistries”, “searchFilter”, and “host” entries you copied from the Con-
tent Engine file, in the location shown above.

v. Save and close the file.
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vi. Restart WebSphere, and log in to the Administrative Console.

vii. Navigate to Security > Secure administration, applications and infrastructure.

NOTE If you make any changes to your LDAP server settings in the WebSphere 
Administrative Console after updating the security.xml file, these settings will be 
overwritten and you will have to add the entries back to the file.

j. Turn on (check) the Enable administrative security flag.

k. Turn off (uncheck) Use Java 2 security to restrict application access to local resources.

l. Click Apply, and then click Save changes to the Master Configuration.

6. Set permissions for the user running the application server.

If the user who will be running the application server is different from the user that installed 
IBM FileNet Workplace XT, you must give the user read/write permissions on the following 
folder:

UNIX - <install_path>/FileNet/WebClient

Windows - <install_path>\FileNet\WebClient (only required for NTFS formatted partitions)

where <install_path> is the location where you installed Workplace XT. The default is /opt 
(UNIX) or C:\Program Files (Windows).

7. Stop and restart the application server. 

8. Continue with “To configure the server ports (optional)” on page 43, or continue with “Install IBM 
FileNet Workplace XT Software Updates” on page 58.

To configure the server ports (optional)

NOTE The following procedure is optional, and applies if you want your LISTENER ADDRESSES 
to be static.

1. Stop the WebSphere server.

2. Make a backup copy of serverindex.xml located in:

<WAS_HOME>/profiles/default/config/cells/<machine_name>Node01Cell/nodes/
<machine_name>Node01/serverindex.xml

3. Use a text editor to open and edit serverindex.xml.

4. Locate the <specialEndpoints> section, and change the port numbers for the three SSL listener 
addresses to “0” as shown below:

<specialEndpoints xmi:id="NamedEndPoint_1155689929072" 
endPointName="SAS_SSL_SERVERAUTH_LISTENER_ADDRESS">
  <endPoint xmi:id="EndPoint_1155689929072" host="host_name" port="0"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_1155689929073" 
endPointName="CSIV2_SSL_SERVERAUTH_LISTENER_ADDRESS">
  <endPoint xmi:id="EndPoint_1155689929073" host="host_name" port="0"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_1155689929074" 
endPointName="CSIV2_SSL_MUTUALAUTH_LISTENER_ADDRESS">
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  <endPoint xmi:id="EndPoint_1155689929074" host="host_name" port="0"/>
</specialEndpoints>

5. Save and close the serverindex.xml file.

6. Restart the WebSphere server.

7. Continue with “Install IBM FileNet Workplace XT Software Updates” on page 58.
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Task 4b: Configure IBM FileNet Workplace XT 
(WebLogic)
This topic covers the configuration of your IBM FileNet Workplace XT application on WebLogic.

NOTE Workplace XT uses cookie names for passing session information between Workplace XT and the 
client browser. This session information affects how Workplace XT interacts with several applets, such as 
Process Designer, Search Designer, and Process Simulator. To avoid forcing end users to log in 
individually to each applet, do not configure the application server to use application-unique cookie names 
for the deployed Workplace XT. For best results, use JSESSIONID for the cookie name.

To configure IBM FileNet Workplace XT

Perform the following high-level steps in the order listed, using the referenced detailed procedures 
for each step.

1. (Optional) If you are using SSO, edit web.xml. See “To edit web.xml for SSO (optional)” on 
page 45.

2. Modify the application server startup script. See “To modify the application server startup script” on 
page 47.

3. (Optional) If you are using Application Integration or another optional product that require user 
tokens, configure WebLogic to support it. Do one of the following:

• “To configure WebLogic 8.1.x to support user tokens for Workplace XT (including Application Inte-
gration) (optional)” on page 50

• “To configure WebLogic 9.x to support user tokens for Workplace XT (including Application Inte-
gration) (optional)” on page 51

4. Configure IBM FileNet Workplace XT. Do one of the following:

• “To configure IBM FileNet Workplace XT (WebLogic 8.1.x)” on page 51

• “To configure IBM FileNet Workplace XT (WebLogic 9.x)” on page 52.

To edit web.xml for SSO (optional)

NOTES

• Perform this procedure only if your site uses SSO. This procedure modifies the web.xml to 
enable SSO.

• If you are implementing SSO in an IBM Tivoli Access Manager WebSEAL 6.0 environment, the 
junction you use for Workplace XT must be a transparent junction. For more details, see your 
IBM product documentation.

1. Make a backup copy of web.xml.

UNIX - <install_path>/FileNet/WebClient/WorkplaceXT/WEB-INF/web.xml

Windows - <install_path>\FileNet\WebClient\WorkplaceXT\WEB-INF\web.xml
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where <install_path> is the location where you installed IBM FileNet Workplace XT. The 
default is /opt (UNIX) or C:\Program Files (Windows).

2. Use a text editor to open and edit web.xml.

3. Set the parameter perimeterChallengeMode to true, as in:

<init-param>

<param-name>perimeterChallengeMode</param-name>

<param-value>true</param-value>

</init-param>

4. As needed, set the ssoProxyContextPath, ssoProxyHost, ssoProxyPort, and 
ssoProxySSLPort. These parameter values are used to modify one or more elements of the 
native URL that Workplace XT sees on a request. Wherever the value of an SSO proxy host 
element in the URL request is different from the equivalent information for the host where 
Workplace XT is deployed, then you must set the corresponding sso* parameter for that 
element in the URL to the value for the SSO proxy host. 

The default settings are:

<init-param>
<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyHost</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyPort</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxySSLPort</param-name>
<param-value></param-value>

</init-param>

In general, the init parameters above should be configured as follows:

• ssoProxyContextPath: Set the value to the context path of the SSO proxy host URL. This is the 
path portion of the URL that appears after the server name, and which represents top-level access 
to the Workplace XT application. For example, if the IBM FileNet Workplace XT deploy host URL is 
http://deploy_server:2809/WorkplaceXT and the SSO proxy host URL is 
http://sso_proxy_server.domain.com/fn/WorkplaceXT, then use the following:

<param-name>ssoProxyContextPath</param-name>
<param-value>/fn/WorkplaceXT</param-value>

• ssoProxyHost: Set the value to the SSO proxy host server name. Typically, this will be a full 
domain-qualified hostname. For example, if the host URL where IBM FileNet Workplace XT is 
deployed is 
http://deploy_server/WorkplaceXT and the corresponding SSO proxy host URL is 
http://sso_proxy_server/WorkplaceXT, then use the following:

<param-name>ssoProxyHost</param-name>
<param-value>sso_proxy_server</param-value>
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• ssoProxyPort: Set the value to the http port on the SSO proxy host. For example:

<param-name>ssoProxyPort</param-name>
<param-value>80</param-value>

• ssoProxySSLPort: Set the value to the https port on the SSO proxy host, if defined and/or used to 
access IBM FileNet Workplace XT pages. For example:

<param-name>ssoProxySSLPort</param-name>
ram-value>443</param-value>

5. Save your changes to web.xml and close the file.

To modify the application server startup script

1. If the WebLogic server is running, stop the server.

2. Make a backup copy of the application server startup script.

• If you are using a WebLogic domain, modify startWebLogic.cmd for Windows or 
startWebLogic.sh for UNIX.

•  If you are not using a WebLogic domain, modify startWLS.cmd for Windows or startWLS.sh for 
UNIX. 

3. Use a text editor to open and edit the application server startup script. 

a. Do one of the following to edit the MEM_ARGS settings:

• For all systems except those using JRockit JAVA:

Find the MEM_ARGS variable and append the following to any existing settings:

–XX:MaxPermSize=<size>m

where <size> is the value, in MB, of the MaxPermSize. Refer to your application server 
vendor's recommendation for a value for your configuration. For more information on 
performance tuning, see the IBM FileNet P8 Platform Performance Tuning Guide. To 
download this and other IBM FileNet product documentation from the IBM web site, 
see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 9.

• For  systems using JRockit JAVA:

Find the MEM_ARGS variable and append the following to any existing settings:

–Xgc:gencon

NOTE If the MEM_ARGS variable doesn't exist, add it to the startup script.

b. Configure JAAS login. Add one of the following right after the classpath entry for WebLogic. 
Do not enter the line break shown after config=. The set jaas_login entry should all be on a 
single line. 

• New install - AIX

# Jaas Login configuration setting
jaas_login=”${jaas_login} -Djava.security.auth.login.config=
”/opt/FileNet/WebClient/CE_API/config/jaas.conf.WebLogic”
jaas_login="${jaas_login} -
Dlogin.configuration.provider=com.ibm.security.auth.login.ConfigFile
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where <install_path> is the location where you installed Workplace XT. For example, 
"/opt/FileNet/WebClient/CE_API/config/jaas.conf.WebLogic".

• New install - UNIX

# Jaas Login configuration setting
jaas_login=”${jaas_login} -Djava.security.auth.login.config=
”<install_path>/FileNet/WebClient/CE_API/config/jaas.conf.WebLogic”

where <install_path> is the location where you installed Workplace XT. For example, 
"/opt/FileNet/WebClient/CE_API/config/jaas.conf.WebLogic".

• New install - Windows

@REM Jaas Login configuration setting
set jaas_login=%jaas_login% -Djava.security.auth.login.config=
”<install_path>\FileNet\WebClient\CE_API\config\jaas.conf.WebLogic”

where <install_path> is the location where you installed Workplace XT. For example, 
"C:\Program Files\FileNet\WebClient\CE_API\config\jaas.conf.weblogic".

• Upgrade - AIX

# Jaas Login configuration setting
jaas_login=”${jaas_login} -Djava.security.auth.login.config=
”/opt/FileNet/WebClient/CE_API/config/jaas.conf.WebLogic”
jaas_login="${jaas_login} -
Dlogin.configuration.provider=com.ibm.security.auth.login.ConfigFile

where <install_path> is the location where you installed Workplace XT. For example, 
"/opt/FileNet/WebClient/CE_API/config/jaas.conf.WebLogic".

• Upgrade - UNIX

# Jaas Login configuration setting
jaas_login=”${jaas_login} -Djava.security.auth.login.config=
”<install_path>/FileNet/WebClient/CE_API/config/jaas.conf.WebLogic”

where <install_path> is the location where you installed Workplace XT. For example, 
"/opt/FileNet/WebClient/CE_API/config/jaas.conf.WebLogic".

• Upgrade - Windows

@REM Jaas Login configuration setting
set jaas_login=%jaas_login% -Djava.security.auth.login.config=
”<install_path>\FileNet\WebClient\CE_API\config\jaas.conf.WebLogic”

where <install_path> is the location where you installed Workplace XT. For example, 
"C:\Program Files\FileNet\WebClient\CE_API\config\jaas.conf.weblogic".

c. Add %jaas_login% section as indicated in the examples below in bold.

• WebLogic 8 - UNIX - after the CLASSPATH settings

# JAAS login config file
JAAS_LOGIN="${JAAS_LOGIN} -Djava.security.auth.login.config=/opt/FileNet/Config/
WebClient/jaas.conf.weblogic"

# Call WebLogic Server
echo "."
echo "CLASSPATH=${CLASSPATH}"
echo "."
echo "PATH=${PATH}"
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echo "."
echo "***************************************************"
echo "*  To start WebLogic Server, use a username and   *"
echo "*  password assigned to an admin-level user.  For *"
echo "*  server administration, use the WebLogic Server *"
echo "*  console at http://[hostname]:[port]/console    *"
echo "***************************************************"

${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} ${JAAS_LOGIN} -
Dweblogic.Name=${SERVER_NAME} -
Dweblogic.ProductionModeEnabled=${PRODUCTION_MODE} -
Djava.security.policy="${WL_HOME}/server/li

b/weblogic.policy" weblogic.Server

• WebLogic 8 - Windows - after the CLASSPATH settings

echo .
echo CLASSPATH=%CLASSPATH%
echo .
echo PATH=%PATH%
echo .
echo ***************************************************
echo * To start WebLogic Server, use a username and *
echo * password assigned to an admin-level user. For *
echo * server administration, use the WebLogic Server *
echo * console at http:\[hostname]:[port]\console *
echo ***************************************************

%JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %jaas_login% -
Dweblogic.Name=%SERVER_NAME% -Dweblogic.management.username=%WLS_USER% -
Dweblogic.management.password=%WLS_PW% -
Dweblogic.ProductionModeEnabled=%PRODUCTION_MODE% -
Djava.security.policy="%WL_HOME%\server\lib\weblogic.policy" weblogic.Server

• WebLogic 9 - UNIX - in the WLS_REDIRECT_LOG settings

${JAVA_HOME}/bin/java ${JAVA_VM} -version

if [ "${WLS_REDIRECT_LOG}" = "" ] ; then
        echo "Starting WLS with line:"
        echo "${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} -
Dweblogic.Name=${SERVER_
NAME} -Djava.security.policy=${WL_HOME}/server/lib/weblogic.policy  
${PROXY_SETTINGS} ${SERVER_CLASS
}"
        ${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} ${JAAS_LOGIN} 
-Dweblogic.Name=${S
ERVER_NAME} -Djava.security.policy=${WL_HOME}/server/lib/weblogic.policy 
${PROXY_SETTINGS} ${SERVER_
CLASS}
else
        echo "Redirecting output from WLS window to ${WLS_REDIRECT_LOG}"
        ${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} ${JAAS_LOGIN} 
-Dweblogic.Name=${S
ERVER_NAME} -Djava.security.policy=${WL_HOME}/server/lib/weblogic.policy 
${PROXY_SETTINGS} ${SERVER_
CLASS}  >"${WLS_REDIRECT_LOG}" 2>&1
fi

• WebLogic 9 - Windows - in the WLS_REDIRECT_LOG settings

If “%WLS_REDIRECT_LOG%”==””(
    echo Starting WLS with line:
    echo %JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %jaas_login%  -
Dweblogic.Name=%SERVER_NAME% -
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Djava.security.policy=%WL_HOME%\server\lib\weblogic.policy %PROXY_SETTINGS% 
%SERVER_CLASS%
    %JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %jaas_login% -
Dweblogic.Name=%SERVER_NAME% -Dweblogic.management.username=%WLS_USER% -
Dweblogic.management.password=%WLS_PW% -
Djava.security.policy=%WL_HOME%\server\lib\weblogic.policy %PROXY_SETTINGS% 
%SERVER_CLASS%
) else (
echo Redirecting output from WLS window to %WLS_REDIRECT_LOG%
%JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %jaas_login% -
Dweblogic.Name=%SERVER_NAME% -Dweblogic.management.username=%WLS_USER% -
Dweblogic.management.password=%WLS_PW% -
Djava.security.policy=%WL_HOME%\server\lib\weblogic.policy %PROXY_SETTINGS% 
%SERVER_CLASS% >”%WLS_REDIRECT_LOG%” 2>&1
)

4. Save and close the application server startup script.

To configure WebLogic 8.1.x to support user tokens for Workplace XT (including Application 
Integration) (optional)

NOTE The configuration steps that follow enable the generation and acceptance of user tokens on 
the server. These settings can be verified in the Bootstrap Settings in the Site Preferences.

1. Stop the WebLogic server.

2. Copy the authentication-weblogic-8.jar file from here:

<install_path>/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:

<WL_home>/server/lib/mbeantypes

3. Copy the log4j-1.2.13.jar file from here:

<install_path>/FileNet/WebClient/WorkplaceXT/WEB-INF/lib

to here:

<WL_home>/server/lib/mbeantypes

4. Restart the WebLogic server, and log in to the administrative console.

5. Navigate to <my_domain> > Domain Wide Security Settings > Realms > myrealm > 
Authentication Providers.

6. Click the link Configure a new User Token Authenticator... to add a new provider.

7. On the General tab, enter the name of the custom provider in the Name field, set the Control 
Flag to SUFFICIENT, then click Create.

8. On the Details tab, enter to the path to the IBM FileNet Workplace XT WcmApiConfig.properties 
file, for example, <install_path>/FileNet/WebClient/WorkplaceXT/WEB-INF/
WcmApiConfig.properties, and click Apply.

9. Return to the Authentication Providers page.

10. Click Re-order the Configured Authentication Providers.
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11. Move the custom provider you created ahead of the LDAP provider, and click Apply.

12. Restart the WebLogic server.

To configure WebLogic 9.x to support user tokens for Workplace XT (including Application 
Integration) (optional)

NOTE The configuration steps that follow enable the generation and acceptance of user tokens on 
the server. These settings can be verified in the Bootstrap Settings in the Site Preferences.

1. Stop the WebLogic server.

2. Copy the authentication-weblogic-9.jar file from here:

<install_path>/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:

<WL_home>/server/lib/mbeantypes

3. Copy the log4j-1.2.13.jar file from here:

<install_path>/FileNet/WebClient/WorkplaceXT/WEB-INF/lib

to here:

<WL_home>/server/lib/mbeantypes

4. Restart the WebLogic server, and log in to the administrative console.

5. Navigate to Home > myrealm > Providers > Authentication.

6. Click on Lock & Edit, then New to add a new provider.

a. In the Name field, enter the name you have chosen for the custom provider.

b. In the Type dropdown list, specify UserTokenAuthenticator.

c. Click OK.

7. Click Reorder, and move the new provider ahead of the LDAP provider. Click OK.

8. Select the new provider to configure settings.

a. On the Configuration tab, set the Control Flag to SUFFICIENT. Click Save.

b. On the Provider Specific tab, enter the path to the IBM FileNet Workplace XT WcmApiCon-
fig.properties file, for example, <install_path>/FileNet/WebClient/WorkplaceXT/WEB-INF/
WcmApiConfig.properties, then click Save.

9. Click Activate Change.

10. Restart the WebLogic server.

To configure IBM FileNet Workplace XT (WebLogic 8.1.x)

1. Enable trust between the Content Engine WebLogic domain  and the Workplace XT WebLogic 
domain.
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NOTE If you have already configured a trust on the Content Engine, perform these steps only 
on the Workplace XT server. You will need to use the same password as the one used on the 
Content Engine.

Do the following on both the Content Engine application server and the IBM FileNet 
Workplace XT application server.

a. Click <my_domain>. 

b. Click View Domain-Wide Security Settings. 

c. Click the Advanced tab. 

d. Uncheck (turn off) Enable Generated Credential.

e. Enter a password for the domain in the Credential field. You must enter the same password 
for both Content Engine and IBM FileNet Workplace XT.

f. Confirm the password by entering it in the Confirm Credential field.

g. Click Apply.

If you are enabling this feature in a managed server environment, you must stop the 
Administration server and all the Managed Servers in both domains and then restart them. 
If this step is not performed, servers that were not rebooted will not trust the servers that 
were rebooted. Refer to your BEA documentation for more information.

2. Configure LDAP settings on IBM FileNet Workplace XT to exactly match the Content Engine 
settings.

a. Refer to your Content Engine installation checklists and the WebLogic Administration Con-
sole settings for Compatibility Security > Realms for Authentication Provider, users, and 
groups on Content Engine.

b. Configure the same LDAP settings on the IBM FileNet Workplace XT Server.

c. Restart the application server. 

3. Continue with “Install IBM FileNet Workplace XT Software Updates” on page 58.

To configure IBM FileNet Workplace XT (WebLogic 9.x)

1. Enable trust between Content Engine WebLogic domain and the IBM FileNet Workplace XT 
WebLogic domain.

NOTE If you have already configured a trust on the Content Engine, perform these steps only 
on the Workplace XT server. You will need to use the same password as the one used on the 
Content Engine.

Do the following on both the Content Engine application server and the IBM FileNet 
Workplace XT application server:

a. In the Change Center of the Administration Console, click Lock & Edit. 

b. Click the name of the domain. 

c. Click the Security tab.
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d. Click General. 

e. Click Advanced. 

f. Enter a password for the domain in the Credential field. You must enter the same password 
for both the Content Engine domain and IBM FileNet Workplace XT domain.

g. Click Save. 

h. Click Activate Changes. 

i. Restart the server if needed.

j. Repeat this procedure in each domain for which you want to enable trust.

If you are enabling this feature in a managed server environment, you must stop the 
Administration server and all the Managed Servers in both domains and then restart them. If 
this step is not performed, servers that were not rebooted will not trust the servers that were 
rebooted. Refer to your BEA documentation for more information.

2. Configure LDAP settings on IBM FileNet Workplace XT to exactly match the Content Engine 
settings.

a. Refer to your Content Engine installation checklists and the WebLogic Administration Con-
sole settings for Compatibility Security > Realms for Authentication Provider, users, and 
groups on Content Engine.

b. Configure the same LDAP settings on the IBM FileNet Workplace XT Server.

c. Restart the application server. 

3. Continue with “Install IBM FileNet Workplace XT Software Updates” on page 58.
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Task 4c: Configure IBM FileNet Workplace XT (JBoss)
This topic covers the configuration of IBM FileNet Workplace XT on JBoss.

NOTE IBM FileNet Workplace XT uses cookie names for passing session information between Workplace 
XT and the client browser. This session information affects how Workplace XT interacts with several 
applets, such as Process Designer, Search Designer, and Process Simulator. To avoid forcing end users to 
log in individually to each applet, do not configure the application server to use application-unique cookie 
names for the deployed Workplace XT. For best results, use JSESSIONID for the cookie name.

To configure IBM FileNet Workplace XT

Perform the following high-level steps in the order listed, using the referenced detailed procedures 
for each step.

1. Modify the application server startup script. See “To modify the application server startup script” on 
page 54.

2. (Optional) If you are using Application Integration or another optional product that require user 
tokens, configure JBoss to support it. See “To configure JBoss to support user tokens for Workplace 
XT (including Application Integration) (optional)” on page 55.

3. Perform additional configuration steps for IBM FileNet Workplace XT. See “To configure IBM 
FileNet Workplace XT (JBoss)” on page 56.

To modify the application server startup script

1. Stop the JBoss application server, if it is running.

2. Make a backup copy of the application server startup script.

Backup run.bat (Windows) or run.sh (UNIX). 

3. Open the application server startup script for editing. 

• (UNIX)  run.sh

• (Windows)  run.bat

4. Edit the Java settings. 

a. Add a line to specify the path to the JDK on the machine where JBoss is installed, as shown 
in the following example (Windows):

set JAVA_HOME=C:\Program Files\Java\jdk1.5.0_06

NOTE  If your JDK is different from version 1.5.0, substitute your version for the one listed 
above. 

b. Update the JAVA_OPTS memory settings.

Adjusting this setting prevents the application server from running out of memory, a 
condition in which users would not be able to log in to Workplace XT.

In the JAVA_OPTS line, change the -Xms and -Xmx values (bold) for your configuration.
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Example (Windows):

set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx512m 

Refer to your application server vendor's recommendation for Initial and Maximum heap 
size values. For IBM specific recommendations, see the IBM FileNet P8 Platform 
Performance Tuning Guide. To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 9.

5. Configure JAAS login. Add one of the following right after the RESTART entry in the startup 
script. 

CAUTION  Enter the jaas_login entry (bold below) as a single line without line breaks.  

• Windows

:RESTART

"%JAVA%" %JAVA_OPTS% -Djava.security.auth.login.config=<install_path>\ 
FileNet\WebClient\CE_API\config\jaas.conf.JBoss "-
Djava.endorsed.dirs=%JBOSS_ENDORSED_DIRS%" -classpath "%JBOSS_CLASSPATH%" 
org.jboss.Main %*

• UNIX

:RESTART

"%JAVA%" %JAVA_OPTS% -Djava.security.auth.login.config=”/<install_path>/FileNet/
WebClient/CE_API/config/jaas.conf.JBoss” "-
Djava.endorsed.dirs=%JBOSS_ENDORSED_DIRS%" -classpath "%JBOSS_CLASSPATH%" 
org.jboss.Main %* 

6. Save and close the application server startup script.

To configure JBoss to support user tokens for Workplace XT (including Application Integration) 
(optional)

NOTE The configuration steps that follow enable the generation and acceptance of user tokens on 
the server. These settings can be verified in the Bootstrap Settings in the Site Preferences.

1. Stop the JBoss server, if it is running.

2. Copy the authentication-utils.jar file from here:

<install_path>/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:

<JBOSS_home>/server/default/lib

3. Modify the login-config.xml file.

a. On the Workplace XT server, open login-config.xml, located in <JBoss_home>/server/
default/conf, for editing.

b. Add the following xml element (bold below) to the FileNet domain section:

<application-policy name="FileNet">

<authentication>
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          <login-module 
code="org.jboss.security.auth.spi.LdapExtLoginModule" flag="required">
          …
          …
          </login-module>
 
         <login-module 
code="com.filenet.ae.authentication.loginmodule.UserTokenLoginModule" 
flag="optional">
              <module-option name="wcmApiConfigPath"><install_path>/FileNet/
WebClient/WorkplaceXT/WEB-INF/WcmApiConfig.properties
              </module-option>
              <module-option name="multi-threaded">true</module-option>
         </login-module>

    </authentication>
</application-policy>

NOTE On Windows, use double back slash (\\) in place of the forward slash in the 
wcmApiConfigPath.

NOTE When deploying as an EAR or WAR file, the wcmApiConfigPath value must be a 
valid folder path, such as the install location.  It cannot point to a folder within the EAR or 
WAR file.

c. Save changes to login-config.xml.

4. Continue with “To configure IBM FileNet Workplace XT (JBoss)” on page 56.

To configure IBM FileNet Workplace XT (JBoss)

1. Stop the JBoss application server, if it is running.

2. Configure LDAP settings on the Workplace XT server to exactly match the Content Engine 
settings.

a. On the Workplace XT server, open login-config.xml, located in <JBoss_home>/server/
default/conf, for editing.

b. Set the <application-policy name="FileNet"> entry identical to the corresponding entry in the  
login-config.xml file on the Content Engine server. 

3. Set permissions for the user running the application server.

If the user who will be running the application server is different from the user that installed 
IBM FileNet Workplace XT, you must give the user read/write permissions on the following 
folder:

UNIX - <install_path>/FileNet/WebClient

Windows - <install_path>\FileNet\WebClient (only required for NTFS formatted partitions)

where <install_path> is the location where you installed Workplace XT. The default is /opt 
(UNIX) or C:\Program Files (Windows).

4. Delete the following directory:

<JBoss_home>/server/default/deploy/jbossweb-tomcat55.sar/jsf-libs
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NOTE If you have applications that depend on the default configuration jsf-libs, you can create 
a new configuration and deploy Workplace XT to it.  See the JBoss Application Server Guide 
(http://docs.jboss.org/jbossas/jboss4guide/r1/html/index.html) for details.

5. Clear out temp directories such as <JBoss_home>/server/default/tmp and 
<JBoss_home>/server/default/work.

6. Disable JBoss logging to prevent unexpected behavior in the deployed IBM FileNet software. 

NOTE When logging is disabled, error messages will still be displayed in the JBoss console.

a. Open the log4j.xml file (<JBOSS_home>/server/default/conf/log4j.xml) for editing.

b. Change all threshold values and priority values from

"INFO"

"DEBUG"

"TRACE" 

to

"ERROR"

c. Insert a priority value for the Root category section, shown in bold below:

<!-- ======================= -->
<!-- Setup the Root category -->
<!-- ======================= -->
<root>

<priority value="ERROR" />
<appender-ref ref="CONSOLE"/>
<appender-ref ref="FILE"/>

</root>

d. Save and close the log4j.xml file.

7. Start JBoss as follows, and leave the command window open:

• (UNIX)  ./run.sh

• (Windows)  run.bat

8. Continue with “Install IBM FileNet Workplace XT Software Updates” on page 58.
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Task 5: Install IBM FileNet Workplace XT Software 
Updates
Install any service packs, fix packs and/or interim fixes required for Workplace XT.

To install the Workplace XT software updates

1. To download the latest software updates, and to determine which of these updates may be 
required for use with other components and expansion products, contact your service represen-
tative or see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 9.

2. Open the readmes for the software updates and perform the installation procedures provided.

3. Install the latest Content Engine and Process Engine client file updates. See Task 6 on page 
59.
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Task 6: Install the Latest Content Engine and Process 
Engine Client Files on Workplace XT Servers
Install any Content Engine or Process Engine client file updates that are available.

To install the Content Engine and Process Engine client files

1. To download the latest software updates, and to determine which of these updates may be 
required for use with other components and expansion products, contact your service represen-
tative or see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 9.

2. Open the readmes for the Content Engine and Process Engine fix packs or mod releases, and 
follow the instructions to do the following:

• Install the updated Content Engine Java client files

• Run the Process Engine Client Updater 

NOTE The client files you install must match the version of your Content Engine and Process 
Engine.

3. Deploy Workplace XT. See the appropriate task according to your application server type:

• Task 7a on page 60 (WebSphere)

• Task 7b on page 65 (WebLogic)

• Task 7c on page 69 (JBoss)
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Task 7a: Deploy IBM FileNet Workplace XT (Web-
Sphere)
This topic covers the deployment and start of your IBM FileNet Workplace XT application on 
WebSphere.

To recreate the WAR and EAR files (optional)

NOTE If you are using a WAR file or EAR file for deployment, and you made any changes to files 
in the /WorkplaceXT directory, you must recreate the WAR file or WAR and EAR files. If you made 
changes to web.xml for SSO support, or any other edits, recreate the WAR and EAR files. 

1. If you will be deploying from a WAR file, verify that web_client.war exists.To recreate the WAR 
file, run one of the following commands:

UNIX

<install_path>/FileNet/WebClient/deploy/create_web_client_war.bat

Windows

<install_path>\FileNet\WebClient\deploy\create_web_client_war.sh

2. If you will be deploying from an EAR file, verify that both web_client.war and web_client.ear 
exist. To recreate the EAR file, first recreate the WAR file, and then run the following command 
to recreate the EAR file:

UNIX

<install_path>/FileNet/WebClient/deploy/create_web_client_ear.bat

Windows

<install_path>\FileNet\WebClient\deploy\create_web_client_ear.sh

NOTE You will need to recreate the WAR and EAR files and redeploy the application any time 
that you make modifications to the contents of the /FileNet/WebClient/WorkplaceXT directory.

To deploy Workplace XT (WebSphere 6.0.x)

1. From the WebSphere Administrative Console, expand Applications. Click Install New Applica-
tion. The “Preparing for the application installation” dialog opens. 

2. (If the Administrative Console is running locally) Select Local Path and enter or browse to the 
location of the .war or .ear file created by the setup program (see below for the default path). Do 
not enter the machine name.

3. (If the Administrative Console is remote) Select Remote File System and enter the fully-qualified 
path to the .war or .ear file. Do not enter the machine name.

The default path is:

UNIX - <install_path>/FileNet/WebClient/deploy

Windows - <install_path>\FileNet\WebClient\deploy
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4. If you are deploying a WAR file, enter the context root: 

Enter Workplace XT and click Next to proceed to deploying a new application.

NOTE The context root is the name of the application you log in to using the web interface, 
such as http://<WorkplaceXTServerName>:<port#>/<Context Root>.

5. On the “Application Security Warning” screen, click Continue.

6. Complete the “Install New Application” screens, as follows. 

a. At “Install New Application”, Step 1, specify the application name.

Enter Workplace XT, or the name you chose to call the application, click Next.

b. At “Install New Application”, Step 2, Map modules to servers, specify the WebServer you are 
planning to use. Check Workplace XT and click Next.

c. At “Install New Application”, Step 3, Map virtual hosts for Web Modules, check Workplace 
XT and keep the default virtual host (default_host), click Next.

d. At “Install New Application”, Step 4, Map security roles to users/groups:

i. In the Select column, select the checkboxes next to the “All authenticated” and “Every-
one” roles.

ii. For the "All authenticated" role row, verify that only the checkbox in the All authenti-
cated? column is selected.

iii. For the "Everyone" role row, verify that only the checkbox in the Everyone? column is 
selected.

iv. Click Next. 

e. At “Install New Application”, Step 5, verify your configuration and click Finish. Once the con-
figuration is saved, click Save to Master Configuration.

7. Configure the Classloader settings.

a. From the Administrative Console, expand Applications. Click Enterprise Applications, and 
click your application (default WorkplaceXT).

b. From the Configuration tab, set Classloader Mode to PARENT_LAST. 

c. Verify that the WAR Classloader Policy is set to Module.

NOTE Do this only for the specific web application. Do not change the similar settings for 
the entire application server.

d. Click Apply.

8. Configure the Web Module Classloader setting.

a. From the Administrative Console, expand Applications.

b. Click Enterprise Applications, and click your application (default Workplace XT). 

c. Under Related Items, click Web Modules. Click web_client.war.

d. From the Configuration tab, set Classloader Mode to PARENT_LAST. 
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NOTE Do this only for the specific web application. There are similar settings for the entire 
application server. Do not change these.

9. Click Apply, click Save, and then click Save changes to the Master Configuration.

10. Set permissions for the user running the application server.

If the local user who will be running the application server is different from the user who 
installed IBM FileNet Workplace XT, you must give the user read/write permissions on the 
following (default) folders:

UNIX:

<WAS_HOME>/profiles/default/installedApps/<node_name>/WorkplaceXT.ear/
web_client.war

<install_path>/FileNet/WebClient

Windows:

<WAS_HOME>\profiles\default\installedApps\<node_name>\WorkplaceXT.ear\web_client.w
ar

<install_path>\FileNet\WebClient

11. Stop and restart the application server.

To deploy Workplace XT (WebSphere 6.1.x)

1. From the WebSphere Administrative Console, expand Applications. Click Install New Applica-
tion. The “Preparing for the application installation” dialog opens. 

2. (If the Administrative Console is running locally) Select Local file system and enter or browse to 
the location of the .war or .ear file created by the setup program (see below for the default path). 
Do not enter the machine name.

3. (If the Administrative Console is remote) Select Remote file system and enter the fully-qualified 
path to the .war or .ear file. Do not enter the machine name.

The default path is:

UNIX - <install_path>/FileNet/WebClient/deploy

Windows - <install_path>\FileNet\WebClient\deploy

4. If you are deploying a WAR file, enter the context root: 

Enter WorkplaceXT and click Next to proceed to deploying a new application.

NOTE The context root is the name of the application you log in to using the web interface, 
such as http://<WorkplaceXTServerName>:<port#>/<Context_Root>. Do not include any 
spaces in the context root.

5. Select Show me all installation options and parameters., and click Next. 

6. On the “Choose to generate default bindings and mappings” page, click Next.

7. Complete the “Install New Application” screens, as follows:
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a. At “Install New Application, Step 1: Select installation options,” specify the application name.

Enter Workplace XT, or the name you chose to call the application, click Next.

b. At “Install New Application, Step 2: Map modules to servers,” specify the WebServer you are 
planning to use. Check WorkplaceXT and click Next.

c. At “Install New Application, Step 3: Provide JSP reloading options for Web modules,” check 
WorkplaceXT, and click Next.

d. At “Install New Application, Step 4: Map shared libraries,” check WorkplaceXT and click 
Next.

e. At “Install New Application, Step 5: Initialize parameters for servlet,” click Next.

f. At “Install New Application, Step 6: Map virtual hosts for Web modules,” check Work-
placeXT, and click Next.

g. At “Install New Application, Step 7: Map context roots for Web modules,” click Next.

h. At “Install New Application, Step 8: Map security roles to users or groups”:

i. In the Select column, select the checkboxes next to the “All authenticated” and “Every-
one” roles.

ii. For the "All authenticated" role row, verify that only the checkbox in the All authenti-
cated? column is selected.

iii. For the "Everyone" role row, verify that only the checkbox in the Everyone? column is 
selected.

iv. Click Next. 

i. At “Install New Application, Step 9: Summary,” verify your configuration and click Finish. A 
successful install message displays. 

8. Once the configuration is saved, click Save directly to master configuration.

9. Configure the Class loader settings.

a. From the Administrative Console, expand Applications. Click Enterprise Applications, and 
click your application (default WorkplaceXT).

b. From the Configuration tab, click Class loading and update detection.  

c. In the Pulling interval for updated files field, type 3.

d. Under Class loader order, Select “Classes loaded with parent class loader first”.

NOTE Do this only for the specific web application. Do not change the similar settings for 
the entire application server.

e. Click Apply. Click Save directly to the master configuration.

10. Configure the Web Module Class loader setting.

a. From the Administrative Console, expand Applications. Click Enterprise Applications, and 
click your application (default WorkplaceXT).
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b. Under Modules, click Manage Modules. Click WorkplaceXT.

c. From the Configuration tab, under Class loader order, select “Classes loaded with applica-
tion class loader first”.

NOTE Do this only for the specific web application. There are similar settings for the entire 
application server. Do not change these.

11. Click Apply, click Save directly to the master configuration.

12. Set permissions for the user running the application server.

If the local user who will be running the application server is different from the user who 
installed IBM FileNet Workplace XT, you must give the user read/write permissions on the 
following (default) folders:

UNIX:

<WAS_HOME>/profiles/default/installedApps/<node_name>/WorkplaceXT.ear/
web_client.war

<install_path>/FileNet/WebClient

Windows:

<WAS_HOME>\profiles\default\installedApps\<node_name>\WorkplaceXT.ear\ 
web_client.war

<install_path>\FileNet\WebClient
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Task 7b: Deploy IBM FileNet Workplace XT (WebLogic)
This topic covers the deployment of your IBM FileNet Workplace XT application on WebLogic.

To recreate the WAR and EAR files (optional)

NOTE If you are using a WAR file or EAR file for deployment, and you made any changes to files 
in the /WorkplaceXT directory, you must recreate the WAR file or WAR and EAR files. If you made 
changes to web.xml for SSO support, or any other edits, recreate the WAR and EAR files. 

1. If you will be deploying from a WAR file, verify that web_client.war exists.To recreate the WAR 
file, run one of the following commands:

UNIX

<install_path>/FileNet/WebClient/deploy/create_web_client_war.bat

Windows

<install_path>\FileNet\WebClient\deploy\create_web_client_war.sh

2. If you will be deploying from an EAR file, verify that both web_client.war and web_client.ear 
exist. To recreate the EAR file, first recreate the WAR file, and then run the following command 
to recreate the EAR file:

UNIX

<install_path>/FileNet/WebClient/deploy/create_web_client_ear.bat

Windows

<install_path>\FileNet\WebClient\deploy\create_web_client_ear.sh

NOTE You will need to recreate the WAR and EAR files and redeploy the application any time 
that you make modifications to the contents of the /FileNet/WebClient/WorkplaceXT directory.

To rename the WAR file (optional)

NOTE This step is optional. Perform this step only if you are using a WAR file for deployment, and 
you want to use “Workplace XT” or a custom name for the context root of the application. The 
context root is part of the URI that end users type to access Workplace XT. 

By default, when you deploy from a WAR file, the context root is the first part of the WAR 
filename. For example, the default web_client.war will generate a context root of http://
<server_name>:<port#>/webclient. If you want to use http://<server_name>:<port#>/
<custom_name>, you must rename web_client.war to <custom_name>.war.

• Use the rename command to rename the WAR file. Enter the command without the line break.

UNIX

rename <install_path>/FileNet/WebClient/deploy/web_client.war  
     <install_path>/FileNet/WebClient/deploy/<custom_name>.war 

Windows

rename <install_path>\FileNet\WebClient\deploy\web_client.war  
     <install_path>\FileNet\WebClient\deploy\<custom_name>.war 
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To deploy Workplace XT (WebLogic 8.1.x)

1. Start the application server.

2. (For WAR file or exploded directory deployment only) Create a new Web Application for WAR 
file or exploded directory deployment:

a. From the WebLogic Server Console, click <mydomain>, click Deployments, and then click 
Web Application Module.

b. Click Deploy a new Web Application Module.

c. From the right pane of the WebLogic Administration Console, do one of the following:

• To deploy from an exploded folder, browse to and select the radio button for the Web-
Client folder in

UNIX - <install_path>/FileNet/WebClient 

Windows - <install_path>\FileNet\WebClient

• To deploy from a WAR file, browse to and select the radio button for the web_client.war 
file in

UNIX - <install_path>/FileNet/WebClient/deploy 

Windows - <install_path>\FileNet\WebClient\deploy

d. Verify that the Name field has the default value, or enter your custom application name.

e. Click Deploy.

NOTE To verify that the deployment was successful, expand Web Applications. The web 
application Workplace XT will be listed.

3. (For EAR file deployment only) Create a new application for EAR file deployment:

a. From the WebLogic Server Console, click <mydomain>, click Deployments, and then click 
Application.

b. Click Deploy a new Application.

c. From the right pane of the WebLogic Administration Console, select one of the following:

UNIX - <install_path>/FileNet/WebClient /deploy 

Windows - <install_path>\FileNet\WebClient \deploy

d. Verify that the Name field has the default value, or enter your custom application name.

e. Click Deploy.

NOTE To verify that the deployment was successful, expand Applications. The application 
Workplace XT will be listed.
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4. Set permissions for the user running the application server. 

If the user that will be running the application server is different from the user that installed 
Application Engine, you must give the user read/write permissions on the following folder:

UNIX - <install_path>/FileNet/WebClient

Windows - <install_path>\FileNet\WebClient (only required for NTFS formatted partitions)

where <install_path> is the location where you installed Workplace XT. The default is \opt 
(UNIX) or C:\Program Files (Windows).

To deploy IBM FileNet Workplace XT (WebLogic 9.2)

1. Start the application server.

2. From the WebLogic Administration Console, navigate to the domain you created or designated for the 
IBM FileNet Workplace XT in “Configure an Application Server for IBM FileNet Workplace XT 
(WebLogic)” on page 19.

3. Click Deployments.

4. In the Change Center, click Lock & Edit.

5. Click Install.

6. From the right pane of the WebLogic Administration Console, do one of the following:

• To deploy from an exploded folder, browse to and select the radio button for the Workplace XT 
folder in:

UNIX - <install_path>/FileNet/WebClient 

Windows - <install_path>\FileNet\WebClient

• To deploy from a WAR or EAR file, browse to and select the radio button for the web_client.war or 
web_client.ear file in

UNIX - <install_path>/FileNet/WebClient /deploy 

Windows - <install_path>\FileNet\WebClient \deploy

7. Click Next.

8. Accept the defaults for the deployment, except for the name for the deployment. Use Workplace 
XT or the custom name you have chosen instead of “web_client”.

9. Click Finish.

10. Click Activate Changes.

NOTE To verify that the deployment was successful, expand Web Applications. The web 
application name you specified for Workplace XT will be listed.
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE



Task 7b: Deploy IBM FileNet Workplace XT (WebLogic)
To deploy IBM FileNet Workplace XT (WebLogic 9.2)

68
11. After IBM FileNet Workplace XT is deployed, start the application. Navigate to <your_domain> > 
Deployments and select (check) the box next to Workplace XT. Click Start, and then select 
Servicing all requests. 

12. Click Yes to agree to start the application. 
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Task 7c: Deploy IBM FileNet Workplace XT (JBoss)
This topic covers the deployment and start of Workplace XT on JBoss.

To prepare for deployment

Before deploying Workplace XT on JBoss, you must remove any log4j jar files that were installed.

1. Change to the folder where Workplace XT installs the log4j jar files:

<install_path>/FileNet/WebClient/WorkplaceXT/WEB-INF/lib

2. Delete the following files from the folder:

– log4j-1.2.13.jar

– log4j.jar

To recreate the WAR or EAR files (optional)

NOTE If you are using a WAR file or EAR file for deployment, and you made any changes to files 
in the /WorkplaceXT directory, you must recreate the WAR file or WAR and EAR files. If you made 
changes to web.xml for SSO support, or any other edits, recreate the WAR and EAR files. 

1. If you will be deploying from a WAR file, verify that web_client.war exists. To recreate the WAR 
file, run one of the following commands:

UNIX

<install_path>/FileNet/WebClient/deploy/create_web_client_war.sh

Windows

<install_path>\FileNet\WebClient\deploy\create_web_client_war.bat

2. If you will be deploying from an EAR file, verify that both web_client.war and web_client.ear 
exist. To recreate the EAR file, first recreate the WAR file, and then run the following command 
to recreate the EAR file:

UNIX

<install_path>/FileNet/WebClient/deploy/create_web_client_ear.sh

Windows

<install_path>\FileNet\WebClient\deploy\create_web_client_ear.bat

NOTE You will need to recreate the WAR and EAR files and redeploy the application any time 
that you make modifications to the contents of the /FileNet/WebClient/WorkplaceXT directory.

To deploy  as “Workplace XT” or custom name using a WAR file (optional)

NOTE This step is optional. Perform this step only if you are using a WAR file for deployment, and 
you want to use “Workplace XT” or a custom name for the context root of the application. The 
context root is part of the URI that end users type to access Workplace XT. 
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By default, when you deploy from a WAR file, the context root is the first part of the WAR filename. 
For example, the default web_client.war will generate a context root of http://
<server_name>:<port#>/webclient. If you want to use http://<server_name>:<port#>/
<custom_name>, you must rename web_client.war to <custom_name>.war.

• Use the rename command to rename the WAR file. Enter the command without the line break.

UNIX

rename <install_path>/FileNet/WebClient/deploy/web_client.war  
     <install_path>/FileNet/WebClient/deploy/<custom_name>.war 

Windows

rename <install_path>\FileNet\WebClient\deploy\web_client.war  
     <install_path>\FileNet\WebClient\deploy\<custom_name>.war 

CAUTION You must rename the WAR file every time you regenerate it. The 
create_web_client_war.sh/.bat script will by default create a file with the name web_client.war.

To deploy Workplace XT

1. Stop the application server, if it is running.

2. (For exploded directory deployment only)

a. On the JBoss server, copy the WorkplaceXT folder from: 

<install_path>/FileNet/WebClient/

to:

<JBOSS_home>/server/default/deploy/

b. Append the extension .war to the WorkplaceXT folder:

<JBOSS_home>/server/default/deploy/WorkplaceXT.war

3. (For WAR file deployment only) On the JBoss server, copy the web_client.war (or 
custom_name.war) file from:

<install_path>/FileNet/WebClient/deploy/

to:

<JBOSS_home>/server/default/deploy/

• (For EAR file deployment only) On the JBoss server, copy the web_client.ear file from: 

<install_path>/FileNet/WebClient/deploy/

to:

<JBOSS_home>/server/default/deploy/

4. Start or restart the JBoss application server.

5. Verify that the application deployed successfully.
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Verify that the server.log file located in <JBOSS_home>/server/default/log lists deployment of 
the WAR or EAR file you used.
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Configuration/Startup Tasks
To configure IBM FileNet Workplace XT components

1. Set bootstrap preferences. Do Task 8 on page 73.

2. Configure the Process Engine connection point for Workplace XT. Do Task 9 on page 77.

3. Set up Workplace XT SSL security. Do Task 10 on page 78.

4. Perform additional configuration. Do Task 11 on page 81.
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Task 8: Set IBM FileNet Workplace XT Bootstrap Pref-
erences
Bootstrap preferences are a category of site preferences. The first time you log into IBM FileNet 
Workplace XT, the Bootstrap Preferences page opens, displaying the following five bootstrap 
preference groups:

• Security Info (required only when using Application Integration with SSL)

• User Token Settings

• Preference Settings (required)

• Application Integration

• Administrator Access Role

For more information, see the IBM FileNet P8 Help topic User Help > Actions, preferences, and tools 
> Site preferences >  Bootstrap preferences.

NOTES 

• By successfully logging in to IBM FileNet Workplace XT and saving the bootstrap preferences, 
you are verifying IBM FileNet Workplace XT’s basic functionality such as user authentication 
as well as communication and storing of data in Content Engine.

• In addition to the preferences covered in this topic, more preferences can be set for the 
Workplace XT application using Workplace XT Site Preferences. For more information, see 
the IBM FileNet P8 Help topic User Help > Actions, preferences, and tools > Site preferences.

• After the initial bootstrap configuration, users with the Application Engine Administrators role 
can change any of these preferences by signing into IBM FileNet Workplace XT and 
navigating to Admin > Site Preferences > Bootstrap. 

• In a web farm/clustered environment, all Workplace XT installations share site preferences by 
using the same bootstrap.properties file. For more information, see the IBM FileNet P8 
Platform High Availability Technical Notice. To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 9.

• Bootstrap properties are stored in a separate file from other site preferences. The default 
location for this file, bootstrap.properties, is:

<install_path>/FileNet/Config/WebClient

• To allow users to create workflow subscriptions, you must configure the PWDesigner access 
role. For more information, see “To enable user access to the Workflow Subscription Wizard” on 
page 76.

To set the bootstrap properties on first login

1. Log in to Workplace XT: 

a. On any computer, open a browser and type:
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http://<WorkplaceXTServerName>:<port#>/WorkplaceXT

b. Enter a user name and password, and then click Log in. The Bootstrap Preferences page 
opens. 

NOTE The user who initially logs in and sets the bootstrap preferences is automatically 
added to the Application Engine Administrators role. For more information, see the IBM 
FileNet P8 Help topic User Help > Actions, preferences, and tools > Site preferences > Access 
Roles preferences. 

2. (Required only when using Application Integration with SSL) Enter security info.

a. Enter the SSL Host and Port information for the SSL server.

b. Enter the Java Server HTTP port.

Use the Security info preference to redirect Application Integration log-ins through a Secure 
Socket Layer (SSL) server and to identify a remote Java server. This encrypts the user IDs 
and passwords when they travel over the network. See “Set up SSL Security for IBM FileNet 
Workplace XT” on page 78 for instructions on setting up SSL security for one or more IBM 
FileNet Workplace XT installations.

3. Configure user token settings.

User tokens are used by IBM FileNet P8 applications to launch into each other without the 
need for an additional login. 

a. Select whether or not to create user tokens for IBM FileNet Workplace XT (Default: Yes).

b. Select whether or not the application will pick up generated tokens from other applications 
(Default: Yes).

c. Specify a Token timeout interval (1 - 15 minutes).

4. (Required) Specify preference settings.

Preference settings specify the name of the site preference file, its storage location (object 
store), and the documentation server URL (if installed). The site preferences file is checked 
into the object store the first time you log in to IBM FileNet Workplace XT. The site preferences 
are stored as XML data in this file, <Site Preferences for Preferences name>.xml. Use 
Enterprise Manager to access this file, and navigate to Object Stores > Object Store location > 
Root Folder > Preferences.

NOTE The bootstrap preferences are saved in the bootstrap.properties file, and not in the site 
preferences file.

a. Select an object store from the Object store location choice list. The preferences file will be 
saved in this object store. Workplace XT users must have access to this object store.

b. Enter a preference file name in the Preferences name field.  

c.  Enter the documentation server URL in the Documentation server field. 

The format of the URL is:

http://<DocServerName>:<port#>/ecm_help/
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE



Task 8: Set IBM FileNet Workplace XT Bootstrap Preferences
To add a single index for Application Name on the site preferences object store

75
where <DocServerName> is the name of your Java application server where the 
documentation is installed, 
<port#> is the port number, 
and <ecm_help> is the root directory of the documentation web site.

NOTE If no documentation URL is specified, the IBM FileNet Workplace XT Help link will 
default to 
http://localhost. 

5. Configure Application Integration.

Select No (default) if you do not want users to be prompted to add an email to an object store 
each time the email is sent.

Select Yes if you want users prompted to add an email to an object store when the email is 
sent.

This preference setting only affects Outlook integration.

6. Add IBM FileNet Workplace XT Administrators (Application Engine Administrators).

Add the users and groups that will perform IBM FileNet Workplace XT administration tasks to 
the Application Engine Administrators role. 

NOTES 

• The user who initially signs in and sets the bootstrap preferences is automatically added to the 
Application Engine Administrators role. For more information, see the IBM FileNet P8 Help topic 
User Help > Actions, preferences, and tools > Site preferences > Access Roles preferences.

• To modify the access roles after the initial bootstrap configuration, users with the Application 
Engine Administrators role can use the access roles section of the IBM FileNet Workplace XT Site 
Preferences. Launch IBM FileNet Workplace XT and navigate to Admin > Site Preferences > 
Access Roles. 

7. Click Apply to save your bootstrap settings.

To add a single index for Application Name on the site preferences object store

To properly index access roles and improve login performance on IBM FileNet Workplace XT, you 
must create an index for Application Name on the object store that contains the IBM FileNet 
Workplace XT site preferences. Do this after you have successfully configured the bootstrap 
preferences.

1. On Content Engine, launch the IBM FileNet Enterprise Manager.

2. In the left pane, expand the Object Stores folder.

3. Expand the object store node where your preferences are stored. See “(Required) Specify 
preference settings.” on page 74 above.

4. Expand Other Classes and then Custom Object.

5. Right click Access Role and select Properties.

6. Select the Property Definitions tab.
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7. Select Application Name and click Edit.

8. On the General tab of the Application Name Properties, if the Indexed field shows 'not indexed', 
click Set/Remove.

9. Select Set and then Single Indexed.

10. Click OK to set the index. 

11. Click OK to apply the change and close the Application Name Properties window. 

12. Click OK to close the Access Role Class Properties window.

To enable user access to the Workflow Subscription Wizard

To allow users to create workflows subscriptions, you must configure the PWDesigner access role 
using the Workplace Site Preferences, and give the users appropriate access rights to the 
workflow subscriptions classes. You can perform these steps in any order, and you must perform 
both steps any time you need to add or remove users.

1. Assign users as members of the PWDesigner access role. See the IBM FileNet P8 Help topic 
User Help > Actions, preferences, and tools > Site preferences > Access Roles preferences.

2. Run the security script wizard and load the workplacescript.xml file, located on the Content 
Engine at <install_path>/FileNet/ContentEngine/Scripts/WorkplaceScript.xml, to add accounts 
to the Workflow Designer role.

For more information about how to use the Security Script wizard to assign the Workflow 
Designer role to user or group accounts, see the IBM FileNet P8 Help topic FileNet P8 
Administration > Content Engine Administration > Content Engine Wizard Help > Security Script.

For more information about the workplacescript.xml file and how roles are defined in the 
Enterprise Manager, see the IBM FileNet P8 Help topic FileNet P8 Administration > Content 
Engine Administration > Managing Security > Security Script Wizard.
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Task 9: Configure the Process Engine Connection 
Point for IBM FileNet Workplace XT
Before users can access tasks and work items from IBM FileNet Workplace XT, you must 
configure the Connection Point on the Workplace XT server. Make sure that you have already 
completed these tasks in the IBM FileNet P8 Platform Installation and Upgrade Guide:

• Create a Process Engine Isolated Region

• Create a Process Engine Connection Point

To download this and other IBM FileNet product documentation from the IBM web site, see 
“Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 9.

To configure the connection point

1. Log into IBM FileNet Workplace XT: 

a. On any computer, open a browser and navigate to:

http://<WorkplaceXTServerName>:<port#>/WorkplaceXT

b. Sign in using the same account that you used to set the bootstrap preferences. 

2. Click Admin.

3. Click Site Preferences.

4. Under General Settings > Tasks, select a Process Engine Connection Point from the drop down 
list.

5. Click Apply, then click Exit.

CAUTION Performing Step 6 in an existing environment will destroy all data in the existing region.

6. (For new environments only) Initialize the isolated region.

a. Click Admin.

b. Click Process Configuration Console.

c. Right-click the icon or name of the isolated region you want to initialize, and select Connect 
from the context menu. 

d. Click Action.

e. Click Initialize Isolated Region. 

f. Click Yes at the prompt asking if you want to continue. 

a. Close the Process Configuration Console.

7. In IBM FileNet Workplace XT, click Tasks to confirm that IBM FileNet Workplace XT is 
communicating with Process Engine. 

8. Sign out of Workplace XT. 
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Task 10: Set up SSL Security for IBM FileNet Work-
place XT
This topic describes how to configure IBM FileNet Workplace XT to direct sign-ins through a 
Secure Socket Layer (SSL) https connection. It assumes that Workplace XT has already been 
installed.

Workplace XT supports the following methods of configuring an SSL environment:

• Full SSL support - A single IBM FileNet Workplace XT server, where all of the software is run-
ning under SSL.

• One server SSL redirect - One IBM FileNet Workplace XT server set up to redirect logon 
attempts on the non-SSL port to the SSL port.

To set up full SSL support on a single IBM FileNet Workplace XT Server

1. Enable SSL on the application server that runs Workplace XT (see your SSL documentation).

2. Test the SSL connection by logging into Workplace XT using the following URL:

https://<WorkplaceXTServerName>:<SSL port>/WorkplaceXT

The entire log-in process will be handled by the SSL-enabled host.

For more information about SSL port numbers, see “IBM FileNet Workplace XT Port Numbers” on 
page 107.

To set up SSL redirect on a single IBM FileNet Workplace XT server

1. Enable SSL on the application server that runs IBM FileNet Workplace XT (see your SSL docu-
mentation).

2. Modify the web.xml file in the WEB_INF directory:

a. In the <security_constraint> section, change the parameter, as follows, from

<user-data-constraint>

<description>User data constraints</description>

<transport-guarantee>NONE</transport-guarantee>

</user-data-constraint>

to

<user-data-constraint>

<description>User data constraints</description>

<transport-guarantee>CONFIDENTIAL</transport-guarantee>

</user-data-constraint>
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b. (If you deployed as a WAR file), In the <install_path>/FileNet/WebClient/deploy direc-
tory, run create_web_client_war.bat.

c. (If you deployed as an EAR file), In the <install_path>/FileNet/WebClient/deploy direc-
tory, run create_web_client_war.bat, then create_web_client_ear.bat.

d. Redeploy the application.

3. Sign in to Workplace XT:

a. On any computer, open a browser and type the following URL address:

http://<WorkplaceXTServerName>:<port#>/WorkplaceXT

b. Sign in as a user with Application Engine Administrator access role privileges. For more 
information, see the IBM FileNet P8 Help topic User Help > Actions, preferences, and tools > 
Site preferences > Access Roles preferences.

4. (Applies only when using Application Integration) Set bootstrap preferences:

a. Navigate to Admin > Site Preferences > Bootstrap.

b. Set the Security info Site Preference SSL Host:Port to identify the alias host name and port num-
ber.

Use the IP address of the IBM FileNet Workplace XT server for the SSL Host entry.

For more information, see “(Required only when using Application Integration with SSL) Enter 
security info.” on page 74.

c. Click Apply to save your bootstrap settings.

5. Update the base URL:

a. Navigate to Admin > Site Preferences > Refresh.

b. Enter the Workplace XT Base URL value in the provided field. The URL must contain a valid host 
name, and not contain “localhost" or an IP number. For example, http://myserver:7001/Work-
placeXT.

For more information, see the IBM FileNet P8 Help topic User Help > Actions, preferences, and 
tools > Site preferences > Refresh preferences.

c. Click Refresh to update the base URL.

d. Click Exit to close Site Preferences.

6. Sign out of Workplace XT, and close your browser.

7. Test the SSL connection by signing into Workplace XT using the following URL:

http://<WorkplaceXTServerName>:<non-SSL port>/WorkplaceXT

NOTE You will be redirected to the SSL-enabled port for log in, then back to the non-SSL 
enabled port after log-in is complete. You should receive a warning that you are accessing 
pages over a secure connection (unless you turned this dialog box off), and then Workplace 
XT will open.
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Using Java Applets in an SSL Environment
If you are using a Java applet in an SSL environment, you may experience an 
SSLHandshakeException because the appropriate certificate does not exist on your computer. 
Follow the instructions in the IBM FileNet P8 Help topic User Help > Using Workplace > Basics > Use 
Java Applets to resolve this issue.
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Task 11: Perform Additional Configuration Tasks
Once you have completed the installation and configuration tasks, your Workplace XT application 
will be up and running. Below is a list of additional configuration tasks you can complete (or at 
least review) to prepare the system for general use. Except where noted, the links go to the IBM 
FileNet P8 Help, and start from the Contents panel in:

<Documentation URL, in the form http://webserver:port#/ecm_help>/_start_here.htm 

• Set site preferences for the Workplace XT application. Refer to User Help > Actions, 
preferences, and tools > Site preferences.

• Configure email notification. Refer to FileNet P8 Administration > Process Engine Administration > 
Workflow administration tasks > Coordinating workflow design > Email notification.

• Enable logging. Refer to User Help > Using Workplace XT > Configure Workplace XT > Configure 
Logging.

• Perform other configuration tasks as applicable. For a list of tasks that apply to the full IBM 
FileNet P8 system, see the “Perform Additional Configuration Tasks” in the IBM FileNet P8 
Platform Installation and Upgrade Guide. To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 9.
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Optional Installation Tasks
To perform optional IBM FileNet Workplace XT installation tasks

NOTE You can install the additional or optional IBM FileNet Workplace XT components listed 
below in any order.

• Install IBM FileNet Workplace XT Application Integration. Do Task 12 on page 83.

• Install IBM FileNet Workplace XT File Tracker. Do Task 13 on page 87.

• Deploy multiple Workplace XT instances. Do Task 14 on page 89.



Task 12: Install IBM FileNet Workplace XT Application Integration
To install the Application Integration software interactively

83
Task 12: Install IBM FileNet Workplace XT Application 
Integration
Install Application Integration if you want to integrate IBM FileNet Workplace XT with your 
Microsoft® Office applications and Outlook. Complete the following procedure on each machine 
that will use Workplace XT Application Integration.

NOTES 

• Verify that the client machine meets the platform requirements documented in the IBM FileNet 
P8 Hardware and Software Requirements. To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 9.

• You cannot collocate IBM FileNet Workplace XT Application Integration with clients running 
P8 Workplace Application Integration Toolkit.

• If you plan to use Application Integration with Workplace XT, you must configure your 
application server to support user token settings. See the following procedures for details:

– “To configure WebSphere to support user tokens for Workplace XT (including Application Integra-
tion) (optional) (WebSphere 6.0.x)” on page 33

– “To configure WebSphere to support user tokens for Workplace XT (including Application Integra-
tion) (optional) (6.1.x)” on page 34

– “To configure WebLogic 8.1.x to support user tokens for Workplace XT (including Application Inte-
gration) (optional)” on page 50

– “To configure WebLogic 9.x to support user tokens for Workplace XT (including Application Inte-
gration) (optional)” on page 51

– “To configure JBoss to support user tokens for Workplace XT (including Application Integration) 
(optional)” on page 55

To install the Application Integration software interactively

1. Log in to the client machine using an account that has Administrator privileges.

2. Log in to Workplace XT.

3. Click Tools > Downloads > Download Application Integration for Microsoft(R) Office....

4. In the dialog, do one of the following:

• Click Run to run the program from its current location.

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the ApplicationIntegration.exe file locally, and then click Save. Once the file is saved to your 
hard drive, double-click the file to run the installer.

A setup preparation dialog appears momentarily, followed by the Welcome dialog box for 
Workplace XT Application Integration.

5. Click Next.
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6. Read and accept the license agreement, and then click Next. If you do not accept the license 
agreement, you cannot continue with the install. 

7. Do the following:

• Select the applications you want to integrate, and then click Next.

KEYBOARD TIP Use arrow keys to move up and down the list of applications. Use the 
space bar to access the context menu for any of the applications, and then use the arrow 
keys to select a feature and press Enter.

NOTE The Application Integration Toolkit Components option is required to use Application 
Integration. 

• Under Install to, the default installation path is displayed. Click Change to specify a different loca-
tion on the Change Current Destination Folder dialog box, and then click OK. Click Next.

NOTE You may see two default installation paths - one for Microsoft Office and Outlook, 
and another for the Toolkit Components. The Toolkit Components path only appears when 
the system on which you are installing Application Integration has the Toolkit Components 
currently installed. You cannot modify the Toolkit Components installation path.

8. Enter the server name, port number, and application name that defines the IBM FileNet 
Workplace XT address. The Server Name is the name of the web server running Workplace XT, 
Port is the web server’s assigned port, and Application is the name of your application, for 
example, Workplace XT.

Check Server uses secure connection (SSL) if you are running full SSL to encrypt all 
communication with Workplace XT. 

NOTE You can also leave these fields blank and enter the information when you log in to 
Workplace XT Application Integration.

9. Click Next.

10. Click Install.

11. After the install is complete, click Finish to complete the setup process.

To install the Application Integration software silently

1. Log onto the client machine using an account that has Administrator privileges.

2. Log in to Workplace XT.

3. Click Tools > Downloads > Download Application Integration for Microsoft(R) Office....

4. Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the ApplicationIntegration.exe file locally, and then click Save.

5. Open a DOS command window and change the current directory to the one where 
ApplicationIntegration.exe resides.

6. Type (do not copy and paste) the following at the command line:

ApplicationIntegration.exe /s /v"/qn <additional arguments included in string> 
LICENSE_ACCEPTED=true"
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Use the /s switch and include the /qn switch to launch the install silently.

Refer to the following optional command line values you can also use. Append the values within the string 
containing the arguments.

For example, ApplicationIntegration.exe /s /v"/qn /L*v C:\temp\AppIntSetup.txt 
LICENSE_ACCEPTED=true"

To verify your Workplace XT Application Integration installation

1. Start Microsoft Word.

Command Line Values Installs

ADDLOCAL=ALL All Features

ADDLOCAL=ALL  
REMOVE=OutlookIntegrationFeature 

Office Only

ADDLOCAL=ALL  
REMOVE=OfficeIntegrationFeature

Outlook Only

ADDLOCAL=ALL 
REMOVE=OutlookIntegrationFeature,
OfficeIntegrationFeature

Core Only

Command Line Values Settings

HOST=<host name> Enter the name of the web server running 
Workplace XT.

PORT=<port number> Enter the web server’s assigned port number.

APPLICATION=<application name> Enter the directory in which you installed the 
Workplace XT application files.

SERVER_CONNECTION=1 Set Application Integration to use an https 
connection

SERVER_CONNECTION=0 Set Application Integration to use http 
connection. This is the default if this 
parameter is not passed.

/L*v C:\temp\AppIntSetup.txt Verbose installation log and specify log 
location.
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2. From the File menu, click IBM FileNet Workplace XT, click Open Document, and then click Select 
Item. The Login dialog box opens. 

3. Log in using any valid account. The available object stores in your environment are displayed.

NOTE If you didn’t enter the Workplace XT Address information in Step 8 above, enter the 
server name, port number and application name that defines the Workplace XT address. The 
Server Name is the name of the web server running Workplace XT, Port is the web server’s 
assigned port, and Application is the name of your application, for example, Workplace XT. 
Check Server uses secure connection (SSL) if you use SSL to encrypt all communication with 
Workplace XT. Do not select this option if you use SSL redirect during login. 

4. Close all dialog boxes and close Microsoft Word.

To uninstall or modify Workplace XT Application Integration

1. From the Start menu, click Settings, and then click Control Panel.

2. Click Add/Remove Programs, and then click IBM FileNet Workplace XT Application Integration 
<version>.

3. Do one of the following:

• Click Remove, and then click Yes to confirm you want to uninstall IBM FileNet Workplace XT 
Application Integration.

• Click Change to access maintenance wizard, and then click Next. You can modify, repair, or 
remove Application Integration using the maintenance wizard.

– Do one of the following:

• Select Modify to add or remove integration with Microsoft applications from your 
previous install. For example, if you have both Microsoft Office and Outlook 
installed, you can remove one of the applications using this option. The Custom 
Setup dialog box appears, where you highlight the option you want to add or 
remove. Click Next, and then click Install. Click Finish to complete the process.

• Select Repair if you want to re-install IBM FileNet Workplace XT Application Inte-
gration in order to repair installation errors. Click Next. Click Install to start the 
repair process. Click Finish to complete the process.

• Select Remove to remove IBM FileNet Workplace XT Application Integration from 
your system, and then click Next. Click Remove. Once the application is removed 
from your system, click Finish to complete the process.

To silently uninstall Workplace XT Application Integration

1. Open a command prompt.

2. Enter the following command to uninstall Workplace XT Application Integration:

MsiExec.exe /X{995FB60D-DC35-48BB-B451-681830AEEA9F} /qn
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Task 13: Install IBM FileNet Workplace XT File Tracker
Install File Tracker if you want to use the Workplace XT file tracking feature without installing 
Application Integration. (Installing Workplace XT Application Integration also installs Workplace 
XT File Tracker.) Complete the following procedure on each machine that will use Workplace XT 
File Tracker.

NOTE You cannot collocate Workplace XT File Tracker with clients running Workplace File 
Tracker. 

Verify that the client machine meets the platform requirements documented in the IBM FileNet P8 
Hardware and Software Requirements. To download this guide from the IBM support page, see 
“Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 9.

To install the File Tracker software interactively

1. Log into the client machine using an account that has Administrator privileges. 

2. Log into Workplace XT.

3. Click Tools > Downloads > Download File Tracker..., and do one of the following:

• Click Open to run the program from its current location.

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the FileTrackerXT.exe file locally, and then click Save. Once the file is saved to your hard 
drive, double-click the file to run the installer.

The Welcome Wizard dialog box for Workplace XT File Tracker appears. Another Welcome 
dialog box appears.

4. Click Next.

5. Read the license agreement, and then select I accept the terms to the license agreement, and 
then click Next. If you do not accept the license agreement, you cannot continue with the install. 

6. Do one of the following:

• Click Change if you want to install Workplace XT File Tracker to a different location. Specify the 
location to which you want to install File Tracker, and then click OK. Click Next.

• Click Next to accept the default location.

7. Click Install.

8. After the install is complete, click Finish to complete the setup process.

To install the File Tracker software silently

1. Log onto the client machine using an account that has Administrator privileges and log into 
Workplace XT.

2. Click Tools > Downloads > Download File Tracker...

3. Click Save. In the Save As dialog box, find a location on your machine in which to download and save 
the FileTrackerXT.exe file locally, and then click Save.
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4. Open a DOS command window and change the current directory to the one where FileTrackerXT.exe 
resides.

5. Type the following at the command line: 

FileTrackerXT.exe /s /v"/qn <additional msi arguments included in string> 
LICENSE_ACCEPTED=true"

NOTE Use the /s switch to launch the execution silently and include the /qn switch in the msi string to 
make msi run silently. In addition, be aware of spaces specified between switches in the above 
example. Using the correct spacing ensures a successful silent install.

Refer to the following optional command line values you can also use. Append the values within the string 
containing the msi arguments.

For example, FileTrackerXT.exe /s /v"/qn /L*v C:\temp\FileTrackerSetup.txt 
LICENSE_ACCEPTED=true"

To uninstall IBM FileNet Workplace XT File Tracker

1. From the Start menu, click Settings, and then click Control Panel.

2. Click Add/Remove Programs, and then click IBM FileNet Workplace XT File Tracker <version>.

3. Click Remove, and then click Yes to confirm you want to uninstall IBM FileNet Workplace XT File 
Tracker.

To uninstall IBM FileNet Workplace XT File Tracker silently

1. Open a command prompt.

2. Enter the following command to uninstall IBM FileNet Workplace XT File Tracker:

msiexec.exe /X{8D746557-5081-4A62-951C-14B7F1CD6C52} /qn

Command Line Values Settings

/L*v C:\temp\FileTrackerSetup.txt Verbose installation log and specific log 
location.

NOTE If you intend to specify a log location, 
create the directory before running the silent 
install. If the directory is not created ahead of 
time, the install will fail.
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Task 14: Deploy Multiple IBM FileNet Workplace XT 
Instances
This topic covers deployment of multiple instances of Workplace XT on a single application 
server. Each deployment of Workplace XT must use the same Content Engine, Process Engine, 
and connection point. Each deployment of Workplace XT may use different Site Preference 
settings and may provide access to different object stores.

NOTES 

• The procedure below assumes that you have already installed Workplace XT and deployed 
one instance of the Workplace XT application. You may or may not have signed in and 
configured your bootstrap preferences.

• For more information on how to deploy and manage multiple identical applications, see your 
application server documentation. 

• For WebLogic, deployment using a flat directory is not recommended when there will be 
multiple deployments.

To deploy a second instance of the Workplace XT application

1. Copy the Workplace XT configuration folder.

On the Workplace XT server, make a copy (<WebClient2>) of the Workplace XT configuration 
folder found at:

<install_path>/FileNet/Config/WebClient

and place it in the same directory to create <install_path>/FileNet/Config/WebClient2

2. Copy the deploy folder.

On the Workplace XT server, make a copy (<deploy2>) of the Workplace XT deploy folder 
found at:

<install_path>/FileNet/WebClient/deploy

and place it in the same directory to create <install_path>/FileNet/WebClient/deploy2

3. Delete the .war file and the .ear file from the deploy2 directory.

4. In the <install_path>/FileNet/WebClient/deploy2 directory, edit the create_web_client_war.bat 
or .sh file.

a. Make a backup of the file.

b. Change the following lines:

cd /D  "%WEB_HOME%\WorkplaceXT"

"%WEB_HOME%\_AEjvm\bin\jar" -cf "%WEB_HOME%\deploy\web_client.war" author 
containerSecured css download eprocess FnJavaV1Files images include is js 
operations portlets properties redirect regions scripts select UI-INF utils 
WEB-INF wizards *.jsp
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rem Add P8 eForms if installed.

if exist "%WEB_HOME%\deploy\eforms_add_to_war.bat" call 
"%WEB_HOME%\deploy\eforms_add_to_war.bat"

to this:

cd /D  "%WEB_HOME%\WorkplaceXT"

"%WEB_HOME%\_AEjvm\bin\jar" -cf "%WEB_HOME%\deploy2\web_client2.war" author 
containerSecured css download eprocess FnJavaV1Files images include is js 
operations portlets properties redirect regions scripts select UI-INF utils 
WEB-INF wizards *.jsp

rem Add P8 eForms if installed.

if exist "%WEB_HOME%\deploy2\eforms_add_to_war.bat" call 
"%WEB_HOME%\deploy2\eforms_add_to_war.bat"

to include the modified folder name and the new name for the WAR file, such as 
web_client2.war.

5. If you want to deploy as an EAR file, modify the create_web_client_ear.bat or .sh file in the 
<install_path>/FileNet/WebClient/deploy2 directory to point to the modified folder names and to 
rename the EAR file.

a. Make a backup of the create_web_client_ear.bat or .sh file.

b. Edit the create_ear.bat or .sh file to change these lines:

cd /D  "%WEB_HOME%\deploy"
"%WEB_HOME%\_AEjvm\bin\jar" -cvf "%WEB_HOME%\deploy\web_client.ear" META-INF 
*.war

to this:

cd /D  "%WEB_HOME%\deploy2"
"%WEB_HOME%\_AEjvm\bin\jar" -cvf "%WEB_HOME%\deploy2\web_client2.ear" META-
INF *.war

6. In the Workplace XT install directory, edit the web.xml file.

a. In FileNet\WebClient\WorkplaceXT\WEB-INF, rename web.xml to web.xml.1.

b. Create a copy of web.xml.1, and name it web.xml.

c. In the new web.xml, change the following parameter value:

<param-name>configurationDirectory</param-name> 
<param-value>C:/Program Files/FileNet/Config/WebClient</param-value> 

to set the path to the new configuration folder copy you created in Step 1, for example, 
<install_path>/FileNet/Config/WebClient2

NOTE On Windows, use double back slash (\\) in place of the forward slash in the 
wcmApiConfigPath.

d. (For deployments using the EAR file only) Change the value of the context root to the cus-
tom name you have chosen for the new application instance, for example, Workplace XT2.
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7. Recreate the WAR file by running create_web_client_war.bat or .sh.

8. (For EAR file deployments only) Recreate the EAR file by running create_web_client_ear.bat or 
.sh.

9. Rename the web.xml files.

a. Rename the web.xml file (that applies to the second instance) to web.xml.2.

b. Rename the original file, now called web.xml.1, back to web.xml.

NOTE The original web.xml file is for the original application instance, and web.xml.2 is for the 
new instance. If you need to do further configuration for either instance, you must rename the 
appropriate version of the file to “web.xml” during the configuration.

10. Clean up the bootstrap.properties file.

NOTE If you haven’t yet signed in to the Workplace XT application as part of your first 
Workplace XT installation there is no need to clean up the file. 

When you first sign in to Workplace XT certain values in the bootstrap.properties file, such as 
the name and location of the site preferences file, are set. To use different settings for your 
new Workplace XT application you must remove the existing entries from the copied file. 

The bootstrap.properties file is located in:

<install_path>/FileNet/Config/WebClient2 

Edit the bootstrap.properties file:

• Remove the value entered for the prefName setting - This entry contains the name of the site pref-
erences file stored on the object store.

• Remove the value entered for the objectStoreId - This entry contains the object store name 
where your site preferences will be stored.

• Remove or edit any of the other values as needed.

11. In the relevant configuration files in the new FileNet/Config/WebClient2 directory, remove any 
comments and custom changes that should not apply to the second Workplace XT instance. 

NOTE If you haven’t yet signed in to the Workplace XT application as part of your first 
Workplace XT installation there is no need to clean up the files.

12. Deploy the second Workplace XT instance.

Follow the application server specific procedures below to deploy your second instance of 
Workplace XT using a unique name (<WorkplaceXT2> in the procedure below). 

When deploying the second instance, use the newly created web_client2.war or 
web_client2.ear file (depending on which method you choose) to deploy the application:

<deploy2>/web_client2.war or <deploy2>/web_client2.ear 

• WebSphere - See “Deploy IBM FileNet Workplace XT (WebSphere)” on page 60. 

CAUTION Deploy the WAR file with a different Context Root name, <WorkplaceXT2>.

• WebLogic - See “Deploy IBM FileNet Workplace XT (WebLogic)” on page 65. 
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CAUTION The new application will deploy using the name specified in the context root or 
the name of the WAR file. 

• JBoss - See “Deploy IBM FileNet Workplace XT (JBoss)” on page 69. 

CAUTION Deploy the WAR file with a different Context Root name, <WorkplaceXT2>.

13. Sign in and set bootstrap preferences for the new application.

Use the following URL when signing in to set the bootstrap preferences for your new 
Workplace XT instance.

http://<WorkplaceXTServerName>:<port#>/<WorkplaceXT2>
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Upgrade Procedures

This upgrade section contains the following major topics:

• “Upgrade IBM FileNet Workplace XT” on page 94

• “Upgrade Multiple Instances of IBM FileNet Workplace XT” on page 97
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Task 1: Upgrade IBM FileNet Workplace XT
This task includes IBM FileNet Workplace XT upgrade instructions for all supported application 
servers, for UNIX and Windows platforms. The upgrade installer recreates the IBM FileNet 
Workplace XT folder structure and files needed for Workplace XT. After upgrading the files, and 
any necessary updates, you must also re-deploy the Workplace XT application. These procedures 
are available in previous topics.

To enable screen reader assistive technology for the upgrade tool

If you plan to use JAWS screen reader for the upgrade tool, you must perform the following tasks 
before you begin the upgrade:

1. Ensure that the Sun Java JRE 1.5.0 or 1.5.x is installed on the system where you will be per-
forming the install. 

2. Install the Java Access Bridge (available at http://java.sun.com).

3. Start the JAWS screen reader.

To upgrade the IBM FileNet Workplace XT software

1. Log in to the application server:

UNIX - Log in as a user with write access to the /bin directory and read, write, and execute 
access to the directory where you plan to install IBM FileNet Workplace XT. The user should 
also be a member of the bin group.

Windows - Log in as a member of the local Administrators group or a user with equivalent 
permissions.

2. From Process Task Manager, stop Component Manager (if running), then exit the Process Task 
Manager application.

3. (Windows only) From the Windows Services console, stop the Process WP XT Services 
Manager service.

4. (Windows only) Using the Windows Task Manager, verify that no javaw.exe processes are 
running.

NOTE If the applications in the preceding steps stopped correctly, no Workplace XT-related 
javaw.exe processes should be running. If needed, use Windows Task Manager or some other 
process management tool to stop all javaw.exe processes that are in the directory path 
<install_path>\_WCjvm\bin.

5. Back up, undeploy, and remove the Workplace XT (web_client) web application from the J2EE 
application server.

WebSphere 6.x

a. Backup the deployed Workplace directory:

<WAS_HOME>/profiles/default/installedApps/<node_name>/WorkplaceXT.ear/
web_client.war
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b. Stop the Workplace XT application from the WebSphere administration console.

c. Uninstall the Workplace XT application from Enterprise Applications.

d. Save the changes and stop the WebSphere server.

e. Delete the temporary Workplace XT directory (default: WorkplaceXT) from: 

<WAS_HOME>/profiles/default/temp/<node_name>/<instance>/

WebLogic 8.x and 9.x

a. From the WebLogic administration console stop the Workplace XT Web Application Module.

b. Make a backup copy of the Workplace XT folder or of the deployed Workplace XT directory: 

– <install_path>/WorkplaceXT

– <install_path>/deploy/<application_name>.war

– <install_path>/deploy/web_client.ear

c. Delete the Workplace XT Web Application Module.

d. Stop the WebLogic server.

6. (Optional) Copy existing configuration files.

If you have made custom changes to your configuration files in the deployed location, do the 
following before you upgrade the existing Workplace XT installation.

Copy the following files:

• WcmApiConfig.properties

• web.xml

from the /WEB-INF folder in the backed-up Workplace XT directory created in the previous 
step to the following directory:

<install_path>/WorkplaceXT/WEB-INF/

7. Start the upgrade process in one of the following ways, depending on whether you want to 
upgrade in interactive or silent mode:

• To upgrade IBM FileNet Workplace XT interactively:

i. Access the IBM FileNet Workplace XT 1.1.1.0 installation software package.

ii. Launch the appropriate Setup program (WorkplaceXT-1.1.1.0-<operating_system>.bin/
.exe) and follow the prompts in the wizard screens. The installer detects and copies set-
tings from the previous Workplace XT installation.

iii. Continue with Step 8 on page 96 below.
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• To upgrade IBM FileNet Workplace XT silently:

From a command prompt, navigate to, and execute the installer:

– For UNIX:

./WorkplaceXT-1.1.1.0-<operating_system>.bin -silent  

– For Windows:

WorkplaceXT-1.1.1.0-WIN.exe -silent

8. When the upgrade program is complete, view the web_client_install_log_1.1.1.0.txt file located 
in

UNIX - <install_path>/FileNet/WebClient

Windows - <install_path>\FileNet\WebClient

where <install_path> is the location where you installed Workplace XT. The default is /opt 
(UNIX) or C:\Program Files (Windows).

Verify that no errors or failures were logged. Correct any errors before you proceed.

9. Restart any services you stopped before you began the upgrade.

10. Redeploy Workplace XT. Do one of the following:

• “Deploy IBM FileNet Workplace XT (WebSphere)” on page 60 

• “Deploy IBM FileNet Workplace XT (WebLogic)” on page 65
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Task 2: Upgrade Multiple Instances of IBM FileNet 
Workplace XT
If you are upgrading Workplace XT in an environment where you have multiple instances of 
Workplace XT on a single application server, use the procedure in “Upgrade IBM FileNet Workplace 
XT” on page 94 with the following modifications:

• In Step 5 on page 94 (Back up, undeploy, and remove the Workplace XT web application from 
the J2EE application server): 

– Make backup copies of all deployed instances of Workplace XT.

– Uninstall all deployed instances of Workplace XT.

– Delete the temp directory for all instances of Workplace XT.

• In Step 6 on page 95 (Copy existing configuration files), you must copy the web.xml files for 
each deployed instance of Workplace XT, and give the copy a descriptive name (such as 
web.xml.2).

• After Step 7 on page 95 (Start the upgrade process), do the following:

a. Back up the existing configuration files in <install_path>/FileNet/Config/WebClient2 (and all 
other instances).

b. For each instance, copy the updated configuration files in <install_path>/FileNet/Config/
WebClient to <install_path>/FileNet/Config/WebClient2 (and so forth) and manually edit in 
any custom changes from the old configuration files to the new updated files.

• In Step 9 on page 96 (Redeploy Workplace XT), you must repackage the WAR/EAR files for the 
additional instances of Workplace XT using the modified web.xml files mentioned above. For 
information, see “Deploy Multiple IBM FileNet Workplace XT Instances” on page 89.
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To remove IBM FileNet Workplace XT software

Use the topics below to remove IBM FileNet Workplace XT according to your application server 
type.

• “Remove IBM FileNet Workplace XT (WebSphere)” on page 99.

• “Remove IBM FileNet Workplace XT (WebLogic)” on page 101.

• “Remove IBM FileNet Workplace XT (JBoss)” on page 103
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Remove IBM FileNet Workplace XT (WebSphere)
This task includes IBM FileNet Workplace XT removal instructions for WebSphere on UNIX and 
Windows platforms.

NOTE If you are using Workplace XT with any IBM FileNet add on products, such as IBM FileNet 
eForms, uninstall the add-on products before you uninstall Workplace XT.

To remove the IBM FileNet Workplace XT software

1. Log in to the application server.

• UNIX - Log in as a user with write access to the /bin directory and the directory where IBM FileNet 
Workplace XT is installed.

• Windows - Log in as a user with Administrative rights.

2. If you're running the Component Manager, stop the instances and exit the Process Task 
Manager.

3. Log in to the WebSphere Administrative Console.

4. Uninstall the IBM FileNet Workplace XT application.

a. Stop the IBM FileNet Workplace XT process in the admin console.

b. Uninstall the IBM FileNet Workplace XT application from Enterprise Applications. 

5. Navigate to the /_WCuninst folder under the IBM FileNet Workplace XT installation location. The 
default location is:

• UNIX - /opt/FileNet/WebClient/_WCuninst

• Windows - C:\Program Files\FileNet\WebClient\_WCuninst

6. Run the uninstall program: 

• UNIX - uninstaller.bin

• Windows - uninstaller.exe

NOTE For Windows, you can also use Add/Remove Programs from the Control Panel to 
remove IBM FileNet Workplace XT.

On Windows, when you click Next on the IBM FileNet Workplace XT Uninstaller Welcome screen, the 
second screen asks you to wait while Windows Task Manager service shuts down before continuing 
the uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the 
uninstall wizard from the next screen.

7. Delete the temporary working directory for Workplace XT on the application server:

<WAS_HOME>/temp/<node_name>/<application_server_name>/WorkplaceXT

8. (If IBM FileNet Workplace XT is the only FileNet P8 application installed on the server) Delete 
the <install_path>/FileNet directory. 
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9. (If IBM FileNet Workplace XT is not the only FileNet P8 application installed on the server) 
Delete the following directories:

<install_path>/FileNet/WebClient

<install_path>/FileNet/Config/WebClient

10. (UNIX) Remove the P8TASKMAN_HOME system environment variable.

If IBM FileNet Workplace XT is the only FileNet P8 application running on the server you must 
remove the P8TASKMAN_HOME system environment variable to complete the application 
removal.

WARNING Do not remove the system environment variable if any other IBM FileNet P8 
application is installed on the server.

11. (UNIX only) Delete the following Install Shield directory, which can cause errors when you re-
install IBM FIleNet Workplace XT:

/InstallShield/Universal/FileNet/WebClient
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Remove IBM FileNet Workplace XT (WebLogic)
This task includes IBM FileNet Workplace XT removal instructions for WebLogic on UNIX and 
Windows platforms.

NOTE If you are using Workplace XT with any IBM FileNet add on products, such as IBM FileNet 
eForms, uninstall the add-on products before you uninstall Workplace XT.

To remove the IBM FileNet Workplace XT software

1. Log in to the application server.

• UNIX - Log in as a user with write access to the /bin directory and the directory where IBM FileNet 
Workplace XT is installed.

• Windows - Log in as a user with Administrative rights.

2. If you're running the Component Manager, stop the instances and exit the Process Task 
Manager.

3. Undeploy the IBM FileNet Workplace XT application.

a. Stop the IBM FileNet Workplace XT Web Application Module.

b. Delete the IBM FileNet Workplace XT Web Application Module.

4. Navigate to the /_uninst folder under the IBM FileNet Workplace XT installation location. The default 
location is:

• UNIX - /opt/FileNet/WebClient/_WCuninst

• Windows - C:\Program Files\FileNet\WebClient\_WCuninst

5. Run the uninstall program:

• UNIX - uninstaller.bin

• Windows - uninstaller.exe

NOTE For Windows, you can also use Add/Remove Programs from the Control Panel to 
remove IBM FileNet Workplace XT.

On Windows, when you click Next on the IBM FileNet Workplace XT Uninstaller Welcome screen, the 
second screen asks you to wait while Windows Task Manager service shuts down before continuing 
the uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the 
uninstall wizard from the next screen.

6. Delete the temporary working directory for Workplace XT on the application server:

<WAS_HOME>/temp/<node_name>/<application_server_name>/WorkplaceXT

7. (If IBM FileNet Workplace XT is the only FileNet P8 application installed on the server) Delete 
the <install_path>/FileNet directory. 

8. (If IBM FileNet Workplace XT is not the only FileNet P8 application installed on the server) 
Delete the following directories:
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<install_path>/FileNet/WebClient

<install_path>/FileNet/Config/WebClient

9. (UNIX) Remove the P8TASKMAN_HOME system environment variable.

If IBM FileNet Workplace XT is the only IBM FileNet P8 application running on the server you 
must remove the P8TASKMAN_HOME system environment variable to complete the 
uninstallation.

WARNING Do not remove the system environment variable if any other IBM FileNet P8 
application is installed on the server.

10. (UNIX only) Delete the following Install Shield directory, which can cause errors when you re-
install IBM FIleNet Workplace XT:

/InstallShield/Universal/FileNet/WebClient
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Remove IBM FileNet Workplace XT (JBoss)
This task includes Workplace XT removal instructions for JBoss on UNIX and Windows platforms.

NOTE If you are using Workplace XT with any IBM FileNet add on products, such as IBM FileNet 
eForms, uninstall the add-on products before you uninstall Workplace XT.

To remove the IBM FileNet Workplace XT software

1. Log on to the application server:

• UNIX - logon as a user with write access to the /bin directory. 

• Windows - Log on as a member of the local Administrators group or a user with equivalent permis-
sions.

2. If you're running the Component Manager, stop the instances and exit the Process Task 
Manager.

3. Shut down JBoss.

4. Navigate to the _WCuninst folder under the IBM FileNet Workplace XT installation location. The 
default location is:

• UNIX - /opt/FileNet/WebClient/

• Windows - C:\Program Files\FileNet\WebClient\

5. Run the uninstall program:

• UNIX - uninstaller.bin

• Windows - uninstaller.exe

NOTE For Windows, you can also use Add/Remove Programs from the Control Panel to 
remove IBM FileNet Workplace XT.

On Windows, when you click Next on the IBM FileNet Workplace XT Uninstaller Welcome screen, the 
second screen asks you to wait while Windows Task Manager service shuts down before continuing 
the uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the 
uninstall wizard from the next screen.

6. (If IBM FileNet Workplace XT is the only FileNet P8 application installed on the server) Search 
for the vpd.properties file. If it exists, delete it.

7. (UNIX and Linux) Remove the P8TASKMAN_HOME system environment variable.

If Workplace XT is the only IBM FileNet P8 application running on the server you must remove 
the P8TASKMAN_HOME system environment variable to complete the uninstallation.

WARNING  Do not remove the system environment variable if any other IBM FileNet P8 
application is installed on the server.

8. Remove temporary files and directories.
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a. Remove the web_client.war (or custom_name.war) folder from <JBoss_HOME>/server/
default/deploy/.

b. Remove the Temp working directory for Workplace from <JBoss_HOME>/server/default/
work/MainEngine/localhost/

9. Delete the <install_path> directory. 

10. (UNIX only) Delete the following Install Shield directory, which can cause errors when you re-
install IBM FIleNet Workplace XT:

/InstallShield/Universal/FileNet/WebClient
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Appendixes

This appendixes section contains the following major topics:

• “Encrypt Passwords for Silent Installation and Upgrades” on page 106

• “IBM FileNet Workplace XT Port Numbers” on page 107
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Encrypt Passwords for Silent Installation and 
Upgrades
Several passwords are required to silently install IBM FileNet P8 components. These passwords 
should be encrypted before you enter them in the silent installation resource files. 

To encrypt a password

1. The encryption tool is located on the installation media for Process Engine or Content Engine 
software, in the Tools directory. Copy the following files from the Tools directory to a local drive:

• fnencryptutils - an executable .jar file

• RunEncryptApp - a batch file

2. Run RunEncryptApp.bat to invoke the application. 

3. Enter the appropriate values for the user name and password. 

4. Reenter the password to confirm it.

5. Click Generate.

6. An encrypted password will be generated and displayed in the encrypted password field.

7. Copy and paste this password into the appropriate silent installation resource file.
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IBM FileNet Workplace XT Port Numbers
The table below lists the default port numbers used by IBM FileNet Workplace XT. 

IBM FileNet Workplace XT Ports

WebSphere / WebSphere SSL 9080 / 9443

WebLogic / WebLogic SSL 7001 / 7002

JBoss / JBoss SSL 8080 / 8443

Process Engine (RMI) 32771

Component Manager (Event Port)

NOTE Ensure that this port number is open if you are using 
Component Manager. On UNIX systems, this port is closed by 
default.

32776

Web Services Reliable Messaging Client Port 32777
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Notices
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other 
countries. Consult your local IBM representative for information on the products and services 
currently available in your area. Any reference to an IBM product, program, or service is not 
intended to state or imply that only that IBM product, program, or service may be used. Any 
functionally equivalent product, program, or service that does not infringe any IBM intellectual 
property right may be used instead. However, it is the user’s responsibility to evaluate and verify 
the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this 
document. The furnishing of this document does not grant you any license to these patents. You 
can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual 
Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such 
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES 
CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in 
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new editions of 
the publication. IBM may make improvements and/or changes in the product(s) and/or the 
program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do 
not in any manner serve as an endorsement of those Web sites. The materials at those Web sites 
are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate 
without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) 
the exchange of information between independently created programs and other programs 
(including this one) and (ii) the mutual use of the information which has been exchanged, should 
contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some 
cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are 
provided by IBM under terms of the IBM Customer Agreement, IBM International Program License 
Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, 
the results obtained in other operating environments may vary significantly. Some measurements 
may have been made on development-level systems and there is no guarantee that these 
measurements will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results may vary. Users of 
this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements or other publicly available sources. IBM has not tested those products 
and cannot confirm the accuracy of performance, compatibility or any other claims related to non-
IBM products. Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal 
without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To 
illustrate them as completely as possible, the examples include the names of individuals, 
companies, brands, and products. All of these names are fictitious and any similarity to the names 
and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate 
programming techniques on various operating platforms. You may copy, modify, and distribute 
these sample programs in any form without payment to IBM, for the purposes of developing, 
using, marketing or distributing application programs conforming to the application programming 
interface for the operating platform for which the sample programs are written. These examples 
have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply 
reliability, serviceability, or function of these programs.
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Trademarks
The following terms are trademarks of the International Business Machines Corporation in the 
United States, other countries, or both:

FileNet is a registered trademark of FileNet Corporation, in the United States, other countries, or 
both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United 
States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation 
in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, and service names may be trademarks or service marks of others.

IBM AIX DB2

ibm.com WebSphere Tivoli
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